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Coral reefs around the world face numerous threats, both natural and
anthropogenic, including pollution, natural disasters, invasive species, habitat destruction,
and destructive methods of fishing. Given enough time, coral can recover from natural
disasters, but anthropogenic threats decrease corals’ ability to recover from things such as
hurricanes. It is difficult to protect coral reefs when they are not fully mapped or
understood and without public support for their protection. This project is an attempt to
both understand more about two small coral reefs around the island of Tutuila, American
Samoa and to facilitate public outreach and education about coral reefs in American
Samoa. New benthic zone and structure classifications have been produced for Fagaitua
Bay and for National Park of American Samoa, which extend earlier satellite-based
classifications into much deeper water. Although it is not possible, at this time, to tie
benthic classifications to species or community types, it is hoped that further ground-truth

data may establish some connection between the two.



Government officials and resource managers increasingly use GIS to determine
the locations of critical habitats in need of protection. There is growing concern,
however, that the general public is excluded from the decision-making process due to the
lack of publicly-accessible data. The American Samoa Benthic Terrain Viewer (ASBTV)
is a web-based geographic information system (GIS) that allows users to display data and
conduct simple GIS analyses without the need to purchase stand-alone GIS software. All
of the benthic classifications produced for American Samoa as part of this and other
projects are available on the ASBTV. ASBTV also includes the world’s first web-based
GIS in the Samoan language. Educational modules developed for American Samoa
Community College are also part of the effort to make the public more aware of current
research on the coral reefs in American Samoa. It is also hoped that they will aid in GIS
capacity building efforts by providing students with the opportunity to learn GIS using
local data. The educational modules include a capstone final project where students must
tie in the technical skills they have learned in the class to a real-world problem: a
hypothetical marine protected area proposal. None of these efforts towards public
education, GIS capacity building, and reef protection can stand alone. Without
traditional outreach, Internet outreach is often unsuccessful. Without public support, reef

protection and GIS education will not often be successful.
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1. Introduction

1.1 Overview

Coral reefs are among the Earth’s most diverse and endangered ecosystems. One
of the most serious challenges facing those involved in coral reef protection is that many
of them are poorly understood and have not been mapped to a useful level of detail. For
example, few detailed maps exist for depths below 30 m for coral reefs and only five
percent of the world’s reefs are mapped to a regional scale (Miller and Crosby 1998).
This is a particular problem in remote areas in the western Pacific, where it may be
difficult to deploy the necessary research vessels, mapping systems, and monitoring
instruments. In recent years, mapping the coral reefs with US waters along with creating
more opportunities for public education about coral reefs have been given a higher
priority. The Coral Reef Ecosystem Division has made it a priority to map all coral reefs
within U.S. waters to depths of at least 30 m (Evans et al. 2000).

The importance of geographic information systems (GIS) as a management tool
for coral reefs was recognized at the 2000 Pacific Regional Symposium of the
International Coral Reef Initiative. One of the goals established was that each Pacific
Island Nation would create a coral reef GIS to help manage and protect its coral reefs by
2010 (Crosby 2002). However, there has been mounting concern that GIS provides
access to information only for well-educated, privileged groups already part of traditional
power structures (Obermeyer 1998; Weiner and Harris 1998). In the developing world,
this problem is exacerbated by a lack of local technological infrastructure and capacity.
Often, few people are trained in GIS in developing countries and many that obtain those

skills leave for developed countries and better salaries. Expatriates, who tend to have a



high rate of turnover, may make up a large percentage of the GIS community (Britton
2000). Many expatriates work on short-term contracts, creating institutional memory and
project longevity problems as well. Local users who do stay may not have much support
or a well-organized GIS community on which to rely when problems and challenges arise
(Britton 2000). Contributing to this problem are research projects done in developing
countries that are often never “brought back” to the societies hosting the research. For
example, researchers may conduct GIS projects in developing countries, but
environmental GIS data and results generated by these projects remain inaccessible to
local resource managers, GIS analysts, and the general public (Britton 2000).

GIS and geography education are keys to development of an active, local GIS
community (Britton 2000). There are at least two things that challenge those in higher
education when trying to encourage students in GIS. Making GIS lessons meaningful to
students is one challenge in creating a set of modules for use in an introductory course.
Using local data may help spark interest among students who otherwise would not relate
to the material used in a GIS class (O’Dea 2002). Often students may be intimidated by
the idea of working with GIS, thinking that it requires more specialized computer skills at
a basic level than it actually does (Mueller and Wickham 2003). There are ways to make
introductory GIS less intimidating, while still making sure students are getting a solid
base of GIS concepts and increasing their interest in science (Hall-Wallace and
McAuliffe 2002). Although many universities and community colleges have GIS courses
and programs now, little has been written about curriculum development in higher

education. Again, this problem is exacerbated in the developing world as stated by



Bishop et al. (2002): “Software, appropriate digital data, relevant educational materials
and an existing skill base among educators may all be in short supply in developing

countries making rapid assimilation and application of the technology difficult.”

1.2 Objectives

The overall purpose of this thesis is to expose the American Samoan public to
GIS in a way that is intuitive and provides a better understanding of the marine resources
around Tutuila. To accomplish this goal, the following three questions need to be
answered: 1) What is the status of coral reefs in American Samoa? Prior to the 2001 and
2002 multibeam sonar surveys, no previous surveys had been done in Fagaitua Bay and
NPSA below 30 m (Wright 2002b, Wright et al. 2002). 2) What is the best way to
provide access to seafloor research and data in American Samoa? As noted earlier,
standard GIS software packages are expensive and require training in order to use. 3)
How best to promote GIS education in American Samoa and to get students thinking
about marine conservation issues? There are GIS classes on-island, but they are currently
using data from off-island.

The overriding goal of this thesis and answers to the questions above will be
accomplished through four main objectives:

1) Creation of benthic terrain characterizations for Fagaitua Bay and the Tutuila

unit of NPSA.

2) Design of a web-based GIS with Samoan- and English-language functionality.

3) Creation of a bibliographic database of marine resources in American Samoa.



4) Development of educational modules about benthic terrain classification and

GIS concepts for use in introductory GIS classes at American Samoa Community

College.

The materials developed as part of this thesis will be made available to the
American Samoa GIS Users Group, agencies on-island, and the general public for public

education about the local coral reefs.

1.3 Justification for Research

Prior to the 2001 and 2002 multibeam surveys, little was known about the
American Samoan coral reefs below 30 m in depth. As stated earlier, they face numerous
threats, but anthropogenic threats hamper coral’s ability to recover from periodic natural
disturbances such as hurricanes. Without knowing more about the deeper areas, both
within MPAs and outside of MPAs in American Samoa, it is difficult for local resource
managers to make management decisions about the reefs under their protection, since
management decisions and threats to the reefs affect the entire reef, not just the shallow
areas. This thesis will provide more information about two of the reefs in American
Samoa, one protected and one outside any MPAs.

Another common problem in ocean science is deciding where to focus resources.
Ideally, every part of the ocean floor would be mapped to sub-meter accuracy and visited
by submersibles; however, money and time are limiting factors in any enterprise. As
noted earlier, little of the ocean floor is mapped to a useful level of detail. The results of
this part of the thesis will help future researchers pinpoint areas in need of further study

on the reefs around American Samoa.



This thesis also addresses some of the need for public education about coral reefs
in American Samoa. Gaining public support for measures to increase protections on
coral reefs is critical to the success of such measures (Fiske 1992). The web-based GIS
will allow the public access to current research being done on the reefs, hopefully
providing the public with a greater understanding of the structure and fragility of the
reefs. There is also a serious need for translations of scientific information into local
languages (Britton 2000; Crosby, Brighouse, and Pichon 2002). Local language
translations reach far more people than would otherwise be reached by a public education
project. This project will add to the currently limited Samoan-language Internet
resources.

Educational modules using local data have the potential to spark students’ interest
in GIS and further technical capacity building efforts in American Samoa. Exposing
local students to GIS early in their post-secondary educations may make them more
likely to pursue further GIS training (West 2003). Lessons using GIS are inherently
associated with a place. Lessons about somewhere halfway around the world can seem
irrelevant, so the educational modules will allow students the opportunity to work with
local data and problems. The modules will also provide exposure to ideas about coral
reef conservation and MPA establishment, while teaching students about how the
seafloor is mapped and studied. In addition to their use at American Samoa Community
College, the modules, along with all of the necessary data, will be available to anyone

with an interest in using them through the Internet.
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Figure 1.1—Location of American Samoa (after NOAA
National Oceanographic Data Center).

1.4 Study Area

American Samoa, a
chain of five volcanic
islands (Tutuila, Aunu’u,
Ofu, Olosega and Ta’u) and
two coral atolls (Rose and
Swains), became a territory
of the United States in 1900.

The islands are located in

the southern Pacific Ocean approximately 2300 miles southeast of Hawaii (Figure 1.1).

The majority of the population and the territorial capital, Pago Pago, are located on the

island of Tutuila, the largest island in American Samoa at 53 square miles (Central

Intelligence Agency 2003).

Coral reefs comprise approximately 296 km” of the territorial waters of American

Samoa (Richmond et al. 2002). They face threats in the form of bleaching events,

hurricanes, sea level rise and from invasive species such as Acanthaster planci (crown-

of-thorns starfish). Given enough time, coral can recover from most such events.

However, the reefs face additional threats from pollution, over-fishing and destructive

fishing methods (e.g. dynamite fishing, fishing with bleach) which can hamper the ability

of coral to recover from natural disasters (Craig et al. 2001; Green et al. 1999; Miller and

Crosby 1998; Richmond et al. 2002). A recent study repeating surveys that had been



done 85 years earlier found serious decline
among soft corals in Pago Pago Harbor, most
likely due to past pollution and habitat
destruction (Cornish and DiDonato 2004). Over-
fishing and habitat destruction are currently
considered the most serious modern threats to the

reefs and fisheries in American Samoa

Figure 1.2—Pufferfish in National Park (Richmond et al. 2002).
of American Samoa (E. Larkin).

Three federal marine protected areas (MPAs) have been established in American
Samoa to help protect coral reefs: Fagatele Bay National Marine Sanctuary (FBNMS),
National Park of American Samoa (NPSA), and Rose Atoll National Wildlife Sanctuary.
FBNMS was established on the southeast end of Tutuila in 1986 with local support (Fiske
1992). National Park of American Samoa (NPSA) was established in 1993 on three
islands: Tutuila, Ofu, and Ta’u (Figure 1.2). NPSA is unique within the U.S. National
Park Service because the land and water rights contained within the park are leased by
the National Park Service from villages that had traditional control over those resources.
Local residents retain limited rights to practice traditional agriculture and fishing within
certain areas of the park (National Park Service 1997). The only no-take MPA in
American Samoa is Rose Atoll National Wildlife Sanctuary, located on the unpopulated,
remote atoll of the same name, which is not included in this study (Richmond et al.

2002). The American Samoa Government’s Department of Marine and Wildlife



Resources has a community-based MPA program that works at the village level to
establish MPAs (Daschbach, pers. comm., 2004).

In addition to being the focus of marine studies, American Samoa, along with
other Pacific U.S. territories, has been the focus of a number of recent GIS-related efforts.
The National Oceanic and Atmospheric Administration’s (NOAA) Pacific Services
Center has obtained high-resolution satellite imagery for American Samoa. There is
currently a partnership program that places an assistant on-island for two years to provide
GIS support (Killpack 2004). NOAA Coastal Services Center also conducted GIS
workshops in 2003 and 2004 for government employees to help build GIS capacity in
American Samoa (J. Murphy, pers. comm. 2004). Oregon State University and the
American Samoa GIS User Group created a memorandum of understanding for exchange

of information, students, researchers and data (Wright 2002a).



2. Benthic Classifications of Fagaitua Bay and National Park of American Samoa

2.1 Benthic Mapping to Inform Resource Management

Resource management in marine settings presents special challenges to managers.
Even in the best situations, seafloor data can be difficult to obtain given the expense of
obtaining that data, the amount of the earth’s surface covered by the ocean and the time
involved in data acquisition. Increasingly, GIS is being applied to management problems
in marine settings. There are a number of ways to map the seafloor, each having its own
advantages and disadvantages. Diving surveys are time-consuming and expensive,
especially if a large area needs to be surveyed, and there is a lower limit to how deep
divers can go. Remotely operated vehicle (ROVs) and submersible surveys are also time-
consuming and expensive. Also, given the limited number of such vehicles, deeper
waters are often given priority over intermediate and shallower areas such as coral reefs.
The advantage of these two methods is that they produce very detailed surveys. Satellite
imagery is also a useful tool for shallow seafloor mapping. It can provide coverage for
large areas with good detail relatively inexpensively and quickly. In good, clear
conditions, satellite imagery such as that from Ikonos can penetrate seawater down to a
depth of 30 m at a resolution up to 4 m (Coyne et al. 2000). Beyond the obvious
limitation of depth, satellite image quality is affected by wind and wave action, turbidity,
and sun angle.

Surveys done with sidescan and multibeam equipment have the advantage of
being able to cover a larger area in a shorter amount of time than either dive or ROV

surveys. They are also able to produce accurate maps even at great depths. Although,
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they do not produce true images of the seafloor, they do produce the underwater
equivalent of a digital elevation model, a bathymetry grid. This grid can then be
processed further to reveal more about the texture and complexity of the area. Multibeam
sonar surveys have the added advantage of being able to collect backscatter information
as well as bathymetry.

Earlier surveys in American Samoa depended on diving transects to map the coral
reefs around Tutuila and the Manu’a Island Group (Craig et al. 2001; Green et al. 1999;
Richmond et al. 2002). These surveys are extremely valuable because they have been
repeated approximately every three years for nearly 20 years, which is one of the longest
time-series data sets for reefs in the Pacific (N. Daschbach, pers. comm. 2004). Although
these surveys produced valuable information, particularly in terms of comprehensive
species lists and rates of recovery after disasters, they were unable to cover large areas
and only the most recent surveys in 2004 were geo-referenced (N. Daschbach, pers.
comm. 2004). Ikonos imagery has been an important tool in classifying benthic terrain
American Samoa. Most of the waters around American Samoa are relatively clear,
allowing for detection of coral to depths of 30 m (Coyne et al. 2002).

Multibeam sonar surveys were completed around Tutuila in 2001 and 2002
(Wright 2002b; Wright et al. 2002). Described here are the creation of benthic zone and
structure maps for Fagaitua Bay and National Park of American Samoa (NPSA) using the
multibeam bathymetry grids produced in the surveys, and incorporating GIS algorithms
for bathymetric position index (BPI), and slope. Fagaitua Bay is a small, shallow inlet on

the southeast side of Tutuila with a fringing reef. The bay is approximately three km
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American Samoa Multibeam N
Sonar Survey Locations XS
Emily M. Larkin, July 12, 2004 S
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Figure 2. ]—Multibeam sonar survey locations around the island of Tutuila, American Samoa.
Areas shown in color are the focus of this study.

across in an east-west direction, although the surveyed area of the bay is approximately
two-thirds that wide. The maximum depth in the surveyed area of the reef is 78 m.
NPSA is the only national park in the United States that is located south of the
equator. The park has units on three of the five volcanic islands in American Samoa:
Tutuila, Ofu, and Ta’u. It is also the only U.S. National Park that includes both terrestrial
and marine resources within the park boundaries (National Park Service 2004). Unlike
Fagaitua Bay, there is no large, wide fringing reef around the Tutuila unit of the park.
This allowed the surveys to come much closer to shore than in Fagaitua Bay. A narrow

swath of seafloor in the offshore portion of the Tutuila unit of NPSA was surveyed in
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2001 at a resolution of 2 m (Wright et al. 2002). The maximum depth in the surveyed
area of the park is 61 m.
In addition to these areas, five others were surveyed at the same time in 2001 and
in later surveys in 2002 (Wright 2002b) and are being analyzed by other researchers

(Figure 2.1).

2.2 Methodology
Several analysis steps are necessary to classify bathymetry into benthic zones and
structures (Figure 2.2). The bathymetry data are in raster format, so analyses were done

primarily either in the Spatial Analyst extension of ArcGIS or in ArcInfo Grid. The first

Slope Bathymetric
Position
L Fine-Scale Broad-
BPI Scale BPI

Bathymetry

\ 4

Benthic Benthic

Structures Zones

Figure 2.2—The basic steps required to produce benthic zone and structure classifications
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step was a slope analysis. Slope compares the elevation, or depths in this case, of each
grid cell to the elevations of surrounding cells to determine the steepness of an area
(Longley et al. 2001). Slope is either calculated as a slope percentage or angle within
Spatial Analyst. For this study, all slopes were calculated in degrees.

Next, BPI was calculated at two different scales to highlight both large and small
features. BPI is based on topographic position index, developed by Andrew Weiss
(2001) for use in classifying terrestrial features. BPI compares the elevation of each pixel
to the elevations of those pixels within a user-defined radius around the pixels to show
peaks and valleys in the data. The shape of the analysis area is user-defined and can
include circle and annulus (a donut shape). The end result is a grid showing the location

of each pixel in relationship to the pixels around it. Positive BPI values indicate crests or

ridges, negative BPI values

pt = =ipi > 0 (ridge)

«<— Elevation at point pt indicate Valleys or

44— Mean Elevation neighborhood 11

depressions and BPI values

pt<p=tipi <0 (valley)
w— Mean Elevation neighborhood 1 of zero indicate either SlOpCS
“#—Elevation at pont pt

or flat areas (Figure 2.3).

pt = = tpi = 0 {comstant slope, flat area, or saddle)
Check slope of the point
Flat Slope values are needed to
Slope Mean Elevation in neighborhood 11t
Mean Elevation in .. .
Neighborhood j b & distinguish between flats and
Elevation at point pt Elevation at point pt
5 slopes (Lundblad 2004;

Weiss 2001). Topographic
Figure 2.3—Bathymetric Position Index (BPI). Areas with
strongly negative BPI values are depressions. Areas with
strongly positive BPI values are ridges or crests. Areas with
values approaching zero are either flats or slopes (after Weiss

position index can be an

indicator for terrestrial
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biodiversity (Weiss 2001). BPI is integral to delineating benthic zones and structures
which have preliminarily been linked to biodiversity (Karlson et al. 2004; Kvitek et al.
2003; Weiss 2001).

By using different scales to look at the data, features of different sizes can be
emphasized. Broad-scale BPI was used to look for large features, such as large valleys or
ridges. In this case, broad-scale BPI focused on features of approximately 250 m in at
least one dimension, after the classification scheme developed for American Samoa by
Lundblad (2004). Fine-scale BPI was used to look for smaller features, such as a ridge
along a larger slope or a valley within a larger flat area (Lundblad 2004). Broad- and
fine-BPI can be combined with slope and bathymetry to delineate general benthic zones
and more specific benthic structures (Lundblad 2004; Whitmire 2003).

Broad-scale BPI was calculated with the following general algorithm in ArcInfo
Grid:

int((bathy-focalmean(bathy, annulus, irad, orad)) + 0.5)

bathy = the input bathymetry grid

irad = the inner radius of the analysis area

orad = the outer radius of the analysis area
Inner radius and outer radius values were chosen based on features of interest in the study
areas (Lundblad 2004).

Fine-scale BPI was calculated using a slightly different formula. Rather than
using an annulus, or donut-shaped, analysis area, a circle was used because the features

of interest were smaller. The inner radius is automatically 1 when a circle is used, so
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there was no need to input an inner radius. As with broad-scale BPI, the outer radius
value was determined by local features of interest, again following the classification
scheme of Lundblad (2004).

Fine-scale BPI was calculated with the following algorithm in ArcInfo Grid:

int((bathy-focalmean(bathy, circle, orad)) + 0.5)

In order to produce consistent classifications that could be compared between
sites, the same scales were used for all BPI calculations in both areas of study. Some
areas analyzed by Lundblad (2004) were calculated using the same methodology, but
different BPI values. This resulted in slightly different classifications using the same
terminology. Fine-scale BPI was determined using a scalefactor of 20. Broad-scale BPI
was produced using a scale factor of 250. Scale factor is determined by multiplying the
resolution of the grid by the outer radius used in the BPI equation. Since the bathymetry
grid for Fagaitua Bay has a resolution of 1 m, this means that, for broad-scale BPI, the
inner radius and outer radius for were 50 and 250, respectively (Figure 2.4). For fine-
scale BPI in Fagaitua Bay, an outer radius of 20 was used (Figure 2.5). Since the
bathymetry grid for NPSA has a resolution of 2 m, the inner and outer radii for broad-
scale BPI were 25 and 125, respectively (Figure 2.6). The fine-scale BPI outer radius
chosen for NPSA was 10 (Figure 2.7). The regular pattern of lines that can be seen in all
of the BPI grids is an artifact from collection of the original bathymetry, likely resulting
from effects of survey boat motion in heavier weather that were not removed completely
in the post-processing. Future work with the bathymetry grids could include application

of a filter to the data (e.g., boxcar, gaussian or median) either to the original multibeam
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data with an analysis package such as Generic Mapping Tools or MBSystem, or to the
GIS version of the data using grid functions in ArcInfo Workstation. These methods were
not applied in this study, as the region has recently been resurveyed by the NOAA Coral
Reef Ecosystem Division, and their grids may also be used for subsequent terrain

classifications.
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BPI grids were then standardized according to the following algorithm so they could be
compared and used in benthic zone and structure calculations:

int((((BPI — mean)/stdv) * 100) + .5)

2.2.1 Benthic Zones

The bathymetry for both areas was classified into four general zones based on
broad-scale BPI and slope values. These classifications and the algorithm are based on
those developed by Lundblad (2004), which was based, in part, on the landform
classification method developed by Weiss (2001). The following algorithm was used in
Arclnfo Grid:

if (B-BPI>=100) out zones =1
else if (B-BPI <=-100) out zones =2
else if (B-BPI > -100 and B-BPI < 100 and slope <= gentle) out zones =3
else if (B-BPI > -100 and B-BPI < 100 and slope > gentle) out zones =4
endif
B-BPI = the standardized broad-scale BPI grid
out zones = the output file
slope = the name of the slope grid
gentle = the slope value used to distinguish between flats and slopes.
Five degrees was used for the slope input value. Grid uses the values of 100 and -
100 to indicate one standard deviation above the mean and below the mean, respectively.
The resulting classifications are indicated by the four numbers:
(1) Crests
(2) Depressions

(3) Flats
(4) Slopes

O O O O
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2.2.2 Benthic Structures

The bathymetry grids were further classified into benthic structures. Benthic
structures are finer classifications than benthic zones. There are thirteen of them, again
based on Lundblad (2004). Again, 5 degrees was used for the gentle slope value, while
70 degrees was used for the extreme slope value. A depth of -15 m was used where the
algorithm calls for a depth value. This value was chosen because there appeared to be a
break in slope values at that point in both study areas. In Fagaitua Bay, for example, the
terrain slopes steeply off of the reef platform down to about 15 m before leveling off.
The following algorithm was used in Grid to create the classifications:

if (F-BPI <=-100 and B-BPI <= -100) out_structures =1

else if (F-BPI <=-100 and B-BPI > -100 and B-BPI < 100 and slope <= gentle )
out _structures =2

else if (F-BPI <=-100 and B-BPI > -100 and B-BPI < 100 and slope > gentle)
out_structures =3

else if (F-BPI <= -100 and B-BPI >= 100) out_structures = 4
else if (F-BPI>-100 and F-BPI < 100 and B-BPI <=-100) out structures =5

else if (F-BPI > -100 and F-BPI < 100 and B-BPI > -100 and slope <= gentle and
bathy <= shallow) out_structures = 6

else if (F-BPI > -100 and F-BPI < 100 and B-BPI > -100 and slope <= gentle and
bathy > shallow) out_structures =7

else if (F-BPI > -100 and F-BPI < 100 and B-BPI > -100 and slope > gentle and
slope <= extreme) out structures = 8

else if (F-BPI>= 100 and B-BPI <= -100) out_structures =9

else if (F-BPI>= 100 and B-BPI > -100 and B-BPI < 100 and slope <= gentle)
out_structures = 10
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else if (F-BPI>= 100 and B-BPI > -100 and B-BPI < 100 and slope > gentle)
out _structures = 11

else if (F-BPI>= 100 and B-BPI >= 100) out structures =12

else if (F-BPI>-100 and F-BPI < 100 and B-BPI > -100 and slope > extreme)
out_structures = 13

endif

B-BPI = broad scale BPI grid

F-BPI = fine scale BPI grid

out zones = name of the output grid

slope = the slope grid derived from bathymetry

gentle = the user defined slope value indicating a gentle slope

bathy = the high-resolution bathymetry grid

shallow = user defined depth that separates the shelf from other broad flats

extreme = the user defined slope value indicative of an extreme slope

The final classification was as follows, again according to Lundblad (2004) to ensure

consistency of classification terminology throughout American Samoa:

O O O O O O O OO0 OO o o0 o

(1) Narrow depression

(2) Local depression on flat

(3) Lateral midslope depression
(4) Depression on crest

(5) Broad depression with an open bottom
(6) Broad flat

(7) Shelf

(8) Open slopes

(9) Local crest in depression
(10) Local crest on flat

(11) Lateral midslope crest

(12) Narrow crest

(13) Steep slope.
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2.3 Results
2.3.1 Fagaitua Bay

Figure 2.8 shows the benthic zone classification for Fagaitua Bay. Figure 2.9
shows benthic structures for Fagaitua Bay. The colors in the figures are a standard color
scheme for benthic zones and structures in American Samoa. Again, the regular pattern
of lines that can be seen in all of the BPI grids is due to a problem with the initial data
collection having to do with correcting for swell. This resulted in the zone and structure
algorithms erroneously classifying the lines as a separate feature.

The area covered by the 2001 multibeam sonar survey overlaps areas classified by
the National Oceanic and Atmospheric Administration (NOAA) Center for Coastal
Monitoring and Assessment using Ikonos imagery (Coyne et al. 2002). With the
exception of a few small areas on the edge of the bathymetry grid, the entire bathymetry
grid lies within an area classified as shelf under the Ikonos-based classifications, which is
a more general classification than used in this project. Additionally, the Ikonos-based
classifications only extend to 30 m in depth.

The results of the benthic zone classification were compared to ground truth
points collected around Tutuila by a group including staff of NPSA (A. Graves, pers.
comm. 2001, as cited in Lundblad 2004). Although a large number of points were
collected within Fagaitua Bay, only twenty-four points were collected within the
surveyed parts of the bay and three of those points did not include any benthic zone
information. No ground-truth points were collected from the deeper portions of the bay

(Figure 2.10). Furthermore, of the twenty-four collected points, fifteen were collected
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within the same benthic zone: Bank/Shelf. The naming system used for the ground truth
points is not the same as the naming system used in this thesis, so comparison between
the two is difficult and somewhat subjective. More ground-truth points using a consistent
naming system are required to truly evaluate the accuracy of the classifications; however,

no more have been collected. That being said, there was some agreement between the

A.

Figure 2.10—Overlap between Ikonos-based classification, ground-truth points, and
bathymetry for Fagaitua Bay. A) About two-thirds of the bathymetry (dark gray) is
overlapped by Ikonos-based classifications. Ikonos-based classifications go down to 30 m in
depth. B) Twenty-four ground-truth points collected by NPSA fall within the bathymetry.

results shown above and the points collected by NPSA. Almost all of the points

classified as Bank/Shelf fall within the area classified as flats in this thesis.

2.3.2 National Park of American Samoa
The same methodology and parameters were used to classify NPSA bathymetry
as for Fagaitua Bay bathymetry. Figure 2.11 shows the benthic zone classifications for

NPSA. Benthic structures are shown in Figure 2.12. There are some areas where the
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surveys appear to overlap the shoreline. Since the post-processing of the data included
tidal corrections based on information from Pago Pago Harbor, most likely the overlap is
due to tides being slightly different on the north side of the island which could have
skewed the post-processing slightly. The same problem with regularly spaced lines
appears in the NPSA grids as well.

No NPSA ground-truth points overlap benthic zones in NPSA, so no error
analysis against these points was possible. Comparison was also not possible between
these classifications and the Ikonos-based classifications because only a small portion of

the former overlap the latter (Figure 2.13).

Regend 8
[ Jland [ ] ReefCrest
ikonos Classification | | ReefFla
ZONE [ shelf
] Backreef [ ] Shelf Escarpment |
[ ] thamel [ ] Shoreline htertidal
[ | Dredged Unknown
[ | Forereef
[ |tagoon

b L B

1000 1500 20

Figure 2.13—The overlap between Ikonos-based classifications
and NPSA bathymetry. It was not sufficient to make any
comparisons between the two.
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2.4 Discussion

Many studies using sonar data use backscatter information to aid in classification
of benthic terrain. Backscatter can give a better idea of the texture of the seafloor based
on the intensity of the return of the signal. In good conditions, backscatter can even be
used to determine the type of substrate (Diaz 2000), which would help distinguish
between the dominant substrate in American Samoa, basalt, and coral. Therefore, more
detailed analyses can be done with backscatter information including several techniques
originally developed for satellite imagery (Hurst and Karson 2004). Unfortunately, no
backscatter was collected in either Fagaitua Bay or NPSA.

Ground-truthing is also needed before any benthic terrain classifications can be
tied to species or fish community types around American Samoa. More ground-truth
points are also needed to extend or refine the Ikonos-based classifications to deeper
water. To date, no ground-truth points below 30 m have been collected around Tutuila.
Karlson et al. (2004), in a study that included American Samoa, indicated that general
benthic terrain type may be correlated with biodiversity. Sloped areas were found to
have a greater number of fish species present than flat areas; however, the study indicated
that more work was needed to refine the results of that study. This is a trend seen not
only in American Samoa, but across the Indo-Pacific region (Karlson et al. 2004). It is
not possible at this time to make any definite conclusions about benthic habitats from
benthic zones or structures. Far more ground-truth work needs to be done to determine if

there is a link between them.
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Benthic classifications such as those produced in this thesis may help researchers
better focus their efforts to study coral reefs by identifying areas in need of more detailed
survey. Although it is not possible to tie benthic zones and structures to specific habitats
or species at this time, there is also evidence that the form of the substrate can influence
species richness. Videography surveys and submersible dives are planned in 2005, with
the hope that a stronger link will be found between benthic terrain and species
assemblages. Since this study identifies areas that may eventually prove to have higher
biodiversity, resource managers may be able to use this information to make better

management decisions with regard to additional MPA designation.
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3. Web-based GIS in American Samoa

3.1 Introduction to web-based GIS

As mentioned earlier, a great deal of mapping and research has been done on the
coral reefs around American Samoa in recent years. This information may eventually be
used to designate new marine protected areas in the territory. Making this information
accessible to the public is an important step in gaining public support for MPAs. The
importance of GIS as a management and public outreach tool for coral reefs was
recognized at the 2000 Pacific Regional Symposium of the International Coral Reef
Initiative (Crosby 2002). One of the goals established was that each Pacific island nation
would create a publicly accessible GIS for management and protection of its coral reefs
by 2010 (Crosby 2002). The advantages of using a GIS are well-known: A GIS can
provide a relatively simple way to manage large, complex data sets. A well-designed
GIS has the capability to display complex information graphically, making it more easily
understood (Al-Kodmany 2001).

There has been mounting concern, however, that GIS provides information and
data access only for well-educated, privileged groups already part of traditional power
structures (Obermeyer 1998; Harris and Weiner 1998). Mainstream GIS software
packages potentially exclude most of the general public from utilizing GIS technology
and spatial data due to cost and inaccessibility to novice users (Peng 2001). One of the
greatest barriers to greater public participation in planning processes is the lack of public
access to spatial information (Barndt 1998). A GIS used in the public realm may also

disproportionately benefit those who already have the technical skills to understand and
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work with it, further disenfranchising those without the necessary technical skills (Al-
Kodmany 2001). In many areas, while spatial data may exist and be used in making
resource management planning decisions, data are not necessarily available to the public
or may be costly and difficult to obtain, and according to Killpack (2004), may be the
most expensive component of any GIS, especially if the data are high resolution satellite
data such as Ikonos and QuickBird. Additionally, data are often scattered among a
myriad of different agencies and organizations, rather than being available from one
central location or clearinghouse (Harris and Weiner 1998). Software and data
compatibility issues and incomplete or non-existent metadata can present further barriers
to distribution of spatial data (Wright et al. 2000). Often, even when data are freely
available and well-documented, users need extensive training and access to expensive
software in order to effectively access the data (Obermeyer 1998). When data are not
readily available, the general public may never get the opportunity to use data in a way
that allows people to draw their own conclusions about natural resources, preventing
them from participating in the decision making process in a meaningful way. Instead, the
public must rely on information presented by government organizations or resource
managers, which can lead to credibility problems, especially if the community sees the
decision-makers as outsiders.

All of the problems with data compatibility and acquisition that are present in
developed areas are exacerbated by the remote locations and lack of technological
infrastructure and capacity of Pacific island nations. Often, few people are trained in GIS

and many who obtain those skills leave for better salaries in areas with higher standards
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of living. Along with intellectual flight, data access is an equally challenging problem in
developing areas. The acquisition of a even single set of imagery may be impossible due
to the cost of the imagery (Killpack 2004). Internet access necessary for download of
data, when they exist, may be slow and unreliable. The benefits of research may never be
made practically available in the areas in which the research was done, preventing local
resource managers and the general public from using information generated by such
projects, and research results may not be translated into the local language (Britton 2000).

A web-based GIS can potentially solve some of the problems of spatial data
distribution. It has the practical advantage of allowing users to work with the data on
their own terms and pace. The Internet can be a very powerful tool for making data
available to far more people than would normally have access to them (Wong and Chua
2001). The only software necessary to use a web-based GIS to view data and conduct
basic analyses is an Internet browser such as Microsoft’s Internet Explorer or The
Mozilla Organization’s Firefox browser. A web-based GIS has several advantages over a
traditional text-and-picture web site: (1) more information can be conveyed in a web-
based GIS than in a traditional web site because several layers may be displayed at once
and in any combination (Green 2001a) and (2) a web-based GIS can serve multiple levels
of users including beginners with little or no GIS experience and more advanced users
needing to download data and metadata for more detailed custom analyses (Peng 2001).
Peng (2001) describes five levels of increasing web-based GIS functionality: (1) a static
map and text displayed on a web page containing little opportunity for user interaction or

input; (2) similar to the first, but various parts of the map may be linked to other pages
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with more information; (3) the map is still static, but some method for user feedback is
provided (e.g. email); (4) a dynamic map allowing the user to customize the display of
the map and control which layers of data are displayed; and (5) a dynamic map that
allows users to edit data layers (although original data sources are protected) for input
into the community planning process. This last level of functionality is most often used
in the planning process where stakeholders may propose alternatives to land or resource
planning decisions (Peng 2001).

Web-based GIS sites are increasingly being used for marine data distribution by
other organizations. Examples include ReefBase (Oliver et al. 2004) and the Moorea
Community Geographic Information System (Edlund and Knupp 2004). Both sites
distribute current research to the general public. Although ReefBase presents information
about coral reefs, it is global in scope, so it cannot readily provide detailed information
about reefs in a specific area. The Moorea Community GIS, a site providing information
about the coastal resources on the island of Moorea, French Polynesia, presents detailed
information about marine protected areas around the island. Users can customize the
display of the map or access GIS data and the site is bilingual: available in both English

and French, further improving accessibility to the residents of Moorea.

3.2 American Samoa and Technology
It is important to have an idea of what Internet infrastructure exists in American
Samoa, since this thesis attempts to solve the problem of data distribution through use of

the Internet. There are approximately 13,000 phone lines in American Samoa (CIA
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2003). There is one Internet service provider in American Samoa, Samoateleco.com,
which provides both dial-up access and expensive digital subscriber line (DSL) access.
Blue Sky Cellular provides wireless Internet access, although it is also fairly expensive.
American Samoa Community College has Internet access in the GIS lab, although it is, at
times, unreliable at the time of writing. Free Internet access is available at the Feleti
Barstow Public Library in PagoPago. Although, there are no data available on the level
of computer ownership or home Internet access, sufficient Internet users exist in
American Samoa that Google, the popular search engine, has a mirror site in American

Samoa (http://www.google.as).

3.3 American Samoa Benthic Terrain Viewer

This study addresses the problem of public outreach and accessibility of scientific
research and data in American Samoa through a web-based GIS called the American
Samoa Benthic Terrain Viewer (ASBTV) and a Samoan-language mirror site, O le
‘Alititai o Amerika Samoa (The Seafloor of American Samoa). Although the problem of
disseminating scientific information is not unique to the Pacific, the remote location of
the territory makes dissemination of current research that directly concerns American
Samoa problematic. While there has been a proliferation of research on the coral reefs
around the territory in the past few years, little of this information is available to the
public in a form that is readily understandable or useable. This information may
potentially be used in the establishment of marine protected areas (MPAs), which, in a
society still partially dependent on subsistence fishing, directly affects the general public

(Gilman 1997). It is vital that the information used in resource management decisions be
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made available to those affected by these decisions. In addition to the general public in
American Samoa, the target audience of the ASBTV includes teachers, community
college and high school students, and local resource managers, as research on coral reefs
can be included in science curriculum.

The ASBTV allows users to access spatial data from the coral reefs in American
Samoa with either an English-language or a Samoan-language interface. The Internet
addresses (URLs) for the websites are:
ASBTYV:
http://scallywag.science.oregonstate.edu/website/ AmSamoa/viewer.htm
O le ‘Alititai 0 Amerika Samoa:
http://scallywag.science.oregonstate.edu/website/Faasamoa/viewer.htm
The data on which the websites are based are multibeam sonar surveys of seven
areas around the island of Tutuila (Figure 2.1). FBNMS, the Tutuila Unit of NPSA,
Taema Bank, Pago Pago Harbor, and Fagaitua Bay were surveyed in 2001 (Wright et al.
2002). In 2002, surveys were conducted in FBNMS, Taema Bank, Vatia Bay and
Coconut Point (Wright 2002b). Benthic zone and structure maps have been created for
the seven study areas from the bathymetry data produced by the surveys. Benthic zones
and structures, in combination with rugosity and visual survey data, may be useful for
identifying particularly sensitive areas in need of protection (Lundblad 2004). The
ASBTYV allows users to access bathymetry data along with the benthic zone

classifications created from the bathymetry data. These data may be used in future
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resource management decisions as part of a larger project involving mapping potential
areas of high biodiversity or particularly sensitive areas.

The ASBTV provides links to the data used to create the site, which are available
for free download. These data and a number of other GIS data sets related to American
Samoa, both terrestrial and marine, are available at the Fagatele Bay National Marine
Sanctuary GIS Data Archive, maintained at Oregon State University (Wright 2001).
However, these data necessitate that the user have GIS software installed locally on his or
her machine and knowledge of how to use it. The ASBTV will allow interested local
residents to keep up with research being done on resources on which they depend as well
as providing an access point for information about the deeper areas of the reef where little
was known previously (Lundblad 2004; Wright et al. 2002).

Also included on the ASBTV is a link to the American Samoa Coastal and Marine
Bibliographic Database. The database, developed by the National Oceanic and
Atmospheric Administration (NOAA) Coastal Services Center (CSC) and Oregon State
University (OSU), contains a record of published resources related to marine issues in
American Samoa. The CSC did the programming necessary to make it available for
inclusion in the ASBTV, while the database was populated at OSU as part of this thesis.

Various library article databases, the Internet, and hard-copy bibliographies were
searched in compiling the database, which includes journal articles, government reports,
conference proceedings, web pages, and books. The earliest reference to marine
resources in American Samoa was a book published in 1842. Sixteen books and articles

were published between 1917 and 1929. There was a large gap in publications between
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1932 and 1952, which is not surprising

HTML Custom . .
given world events at the time. Nearly
Users
Java [nternet - otper three-quarters of the entries have been
- published since 1980.
i ArclMS Application Server
Services

il 5“_””“” | 3.4 Site Architecture

R o atewsy The ASBTV and the Samoan

Data Management

DBMS version, O le ‘Alititai o Amerika Samoa,

Local Enterprise

were created using Arc Internet Map Server

Figure 3.1—Schematic of how users interact
with data in a web-based GIS. Data are
housed and managed in a secure location.
Users connect via the Internet to a web server
that interacts with the data through ArcIMS ArcIMS 9.0), an Internet map server or
connectors (after ESRI 2002b).

(ArcIMS) version 4.01 (later upgraded to

web-based GIS application. In a web-based
GIS, the data necessary to create a map and conduct analyses are housed in one location
and are accessed remotely though the Internet (Figure 3.1). This differs from a traditional
GIS in that the user does not need to install GIS software on his or her computer and does
not need to be able to store large data sets locally on his or her machine. The level of
functionality, accessibility, and complexity in a web-based GIS depends on how it is
designed (Peng and Tsou 2003, O’Dea 2002).

Several different kinds of map services, including image, feature, and metadata
services, can be created in ArcIMS. An image service creates a map image (such as a
Jpg file) from the data layers included in the service and has the capability to display
both vector and raster data. A feature server can display only vector data and requires the

user to download a Java plug-in (a small piece of software) in order to function (ESRI
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2002b). Operations are completed server-side rather than on the user end, reducing the
user’s need for a high-speed computer (ESRI 2002a). The ASBTV was designed as an
image service because of the need to display raster data and to avoid making users
download additional software to use the site. Within an image service, there are two
ways to construct the site: as a hypertext markup language (HTML) image service or as a
Java image service. The Java image service has the same limitation as the feature service
in that it requires the user to download a plug-in (ESRI 2002b). Some users may be wary
of downloading files from the Internet and installing them on their computers, which
precludes using a Java service. Also, users with slow Internet connections, such as 28.8
kbps dial-up connections, may not wish to cause further delay by downloading a plug-in
before using the map service. An HTML image service in ArcIMS is controlled by the
.axl file (ArcIMS extensible markup language (XML)—a derivative of XML) (ESRI
2002b). The .axl file tells the map service in which directories to look for data and how
to display various layers available on the map service including geographic extent and
color schemes. The file is supported by a number of HTML files making up the frames
and their display properties on the site and Java script files that determine how each tool
and button functions on the site (ESRI 2002a, ESRI 2002b).

A certain level of computer literacy is required to use the ASBTV. This is an
inherent problem with GIS and public outreach (Al-Kodmany 2001). Several steps have
been taken to minimize the level of skills necessary to use the ASBTV. The initial

display on the ASBTYV is a hillshaded digital elevation model of the island of Tutuila
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along with the bathymetry for the seven study areas around Tutuila: FBNMS, NPSA,
Taema Bank, Fagaitua Bay, Coconut Point, Pago Pago Harbor and Vatia Bay (Figure
3.2). The user is then able to add or remove layers as he or she wishes by checking or
unchecking the boxes next to the layer names. The featured layers are the benthic zone
and rugosity classifications developed as part of a larger project in the territory (Lundblad
2004). Terrestrial layers such as villages and roads are included to help users orient
themselves on the map. A list of layers on the ASBTV is included in Appendix B. A
dropdown menu allows users to zoom to one of the areas that have been studied
extensively. A number of tools, explained in detail on the help screen, add functionality
to the site. To help users unfamiliar with typical GIS tool images, the default toolbar
images in ArcIMS were replaced with images containing words. For example, rather
than using the default button with a picture of a globe to indicate the function that will
show the full geographic extent of the map, the words Full Extent appear on a button

(Figure 3.3). Included among the tools are those that allow the user to conduct operations

and basic analyses such as measuring

= distances, creating buffers, zooming in and
O = Full Extent o
out, and identifying features. Users can

create maps with a legend, scale bar, title

Replaced Full Extent

With

and north arrow through the print map

Fa'afanua atoa

utility. The site has links to other important

Figure 3.3—Making GIS accessible. Toolbar resources such as the American Samoa

images were replaced with word buttons to
enhance usabilitv. Coastal and Marine Bibliographic Database
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detail next a picture of the tool. The use of words rather
than symbols, such as a magnifying glass to indicate the
zoom function, will aid users unfamiliar with common GIS
tool symbology.

additional screen has been
created with information
about the coral reefs in American Samoa and how they were mapped. The coral reef
page contains links to sites with more detailed information about coral reefs, should the
user be interested in learning more than the ASBTV offers.

The ASBTV and the Samoan version of the site, along with all data, are currently
being hosted at Oregon State University using an Apache 2.0 and Apache Tomcat 4.0
Web Server. The ASBTV and its Samoan counterpart are two separate map services with
separate .axl files and separate sets of HTML and Java files that reference the same data
directories and data. This allows for simpler updates and ensures both sites contain the
same content. If data for existing map service layers need to be updated, they only need

to be done once, but if new layers are to be added, each .axl file must be updated.
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Changing the display language of an ArcIMS map service is accomplished by changing
each display parameter in the Java script file aimsResource.js, changing the titles in the
.axl file, changing several parameters in the aimsParam.js file, and changing the title in

the viewer.htm file.

3.5 Discussion
3.5.1 Technical Challenges

Although the communications infrastructure in American Samoa is at a level to
allow use of the Internet as a public education tool, it appears the ASBTV may be a few
years ahead of its utility in terms of loading times. Preliminary testing indicated that the
ASBTYV would run fairly slow on-island, but on further evaluation it became apparent
that it runs so slowly that its use is likely to be limited to off-island people at the present
time. Internet connections are known to be somewhat unstable and fairly slow in
American Samoa. Static web pages load fairly quickly on most connections; however the
ASBTYV requires a lot of data transfer, slowing things down considerably. Although
Bannan (2002) reported in Pacific Magazine that the public schools in American Samoa
received a grant in 2002 to upgrade Internet access to T-1 connections, not all science or
geography classrooms have computers and teachers still reported that their connections
were slow and loading the site was not possible. The ASBTV works very slowly when
viewed over a 50 kpbs dial-up internet connection, but higher speed connections are
recommended. One less than perfect solution involves the FBNMS GIS Data Archive.

This website allows users to download marine GIS data and to see static images of most
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of the data. While users cannot customize the display or show features in which they are
interested, they can at least view the data.

Although it is not practical to use the ASBTV on-island currently, that does not
mean that it has no purpose. A significant number of Samoans live outside American
Samoa and the independent nation of Samoa, particularly in Australia, New Zealand, and
the United States (US State Department 2004). Many of them still speak Samoan and
maintain close ties to the islands, some of them even returning to live at some point. This
is an audience that may be interested in conservation issues concerning American Samoa.
The ASBTV may also be useful for increasing the awareness of GIS in American Samoa
in the rest of the United States.

The ASBTV definitely works much better on high-speed Internet connections,
such as DSL and T-1 connections. However, the reality in American Samoa is that many
people will be limited to using the site over a dial-up connection, even at many of the
government agencies. Several things were done to make the site load as quickly as
possible, but most likely it simply will not work fast enough. The raster files included on
the site were resampled from resolutions of I m and 2 m to 5 m and 10 m, respectively,
allowing faster loading times. Displaying 5 m grids, rather than 1 m grids, on an ArcIMS
site does not perceptibly diminish the quality of the site or of the display. It does result in
generalization of some features, but the actual, high-resolution data are freely available to
those who have a need for such data.

A second solution involves constructing a geodatabase from the raster layers and

using ArcSDE, a middleware between ArcIMS and a database, to communicate between
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the geodatabase and ArcIMS. This is a particularly useful solution for projects with very
large grids, since geodatabases more efficiently store and index the data. In this case, the
grids are very small—less than 30 Mb each—so the improved loading time would be
offset by the necessity of going through another network connection. Additionally, this
may not be a feasible alternative for all projects of this type due to the expense of the
database program and the skills necessary to administer a database. In addition to a GIS
analyst, the project would need someone adept at database administration.

There are plans to serve and support the sites locally on Tutuila; however, as of
2004, the technological infrastructure is not at a level where this is possible. The
American Samoa GIS User Group has plans to create and host a local ArcIMS site in the
near future, so it may be possible soon. Finding a local host for the ASBTV may greatly
improve loading times, but there are no definite plans to move the site yet.

One possible alternative that should be explored is making data available on
compact discs along with the free data viewer ArcExplorer for a nominal charge to cover
the cost of the CD. This is similar to the approach taken by the City of Corvallis,
Oregon, where data are available for download, but may also be obtained on CD from the
city for ten dollars or may be borrowed from the public library. Taking this approach in
American Samoa would allow those without Internet connections and those with very
slow Internet connections access to data as well. This would also help address the
problem of unstable Internet connections.

There are other challenges associated with using ArcIMS to display raster data

such as benthic zone, structure, and bathymetry grids. Although raster data formats are
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supported in ArcIMS, it is neither easy nor intuitive to display them on an ArcIMS map
service, much less do anything with them. While there is a graphic user interface utility,
ArcIMS Author, to add vector data to an ArcIMS map service, it does not allow the
addition of raster layers. Additionally, if an .axl file containing both raster and vector
layers is opened with Author, it will delete all of the raster layers, even if the .axl file is
not changed or saved. Raster layers must be written into the .axl file by hand. It is also
difficult to make identification of raster pixel values possible. The default programming
in the ArcIMS javaScript files only allows the identify tool to recognize vector layers.
Converting the raster layers to a vector format such as polygon shapefiles is a possible
partial solution to these problems; however, while this may be appropriate for discrete
data such as benthic zones, it is not appropriate for data made up of continuous variables
such as bathymetry grids. Additionally, error is introduced and some data are lost in the
conversion.

The solution to being able to use the identify tool on raster data in ArcIMS
requires javaScript and HTML code editing. The table of contents file (toc.htm) file must
be edited so ArcIMS will allow a raster layer to be made an active layer (a layer must be
“active” to do any analyses on it or to use any tools on it). Without this edit, no radio
button appears next to raster layers allowing users to make a raster layer active. The
following javaScript files must be edited to allow the identify tool to work on raster data:
aimsCustom.js, aimsldentify.js, aimsXML.js, and aimsLayers.js (T. Valentine, pers.
comm. 2004; Valentine and Dodgett 2003). If any of them are omitted, the identify tool

will only work on vector layers or may not work at all. The specific changes can be
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found in Appendix A. Whether using ArcSDE or not, making ArcIMS allow queries on
raster data requires at least some knowledge of javaScript programming, something that
may also be problematic for some projects, particularly in remote areas.

While the bibliographic database provides a useful list of what has been published
about marine resources in American Samoa, it does not solve the problem of availability
of references on-island. Libraries in American Samoa do not have the budget to maintain
subscriptions to a large number of academic journals, where much of the research has
been published. While these may be available through inter-library loan (not necessarily
free-of-charge) or online, government reports and conference proceedings can be even
more difficult to obtain. While the Internet can solve some of the problems of knowing

whether things exist, it cannot always solve the problem of access (Britton 2000).

3.5.2 Social Challenges

In addition to making the ASBTV accessible to as many people as possible,
translating the ASBTV into Samoan adds to the limited Samoan-language resources
available on the Internet. The ASBTV is the only Samoan-language web-based GIS in
existence and it is one of only a handful of Samoan-language sites dealing with scientific
information. Although English is the official language in American Samoa, Samoan is
still widely spoken. Most people converse informally in Samoan and, although almost
everyone knows English, village outreach meetings are conducted in Samoan. Britton
(2002) and Crosby et al. (2001) recognized that scientific information translated into the

local language greatly improves accessibility and can generate more interest in the
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subject area by people who would normally be left out of the information distribution
process. Currently, few official government web pages are translated into Samoan in
either American or the independent nation of Samoa. Brigham Young University-Hawaii
(Fautimau 1998) and an organization in New Zealand, Fagasa, maintain pages dedicated
to learning and preserving the Samoan language and a number of personal web pages
with Samoan content also exist. There are even fewer Internet resources concerned with
scientific research in American Samoa or in the independent nation of Samoa and most of
these contain little if any Samoan language content. A notable exception is the National
Park of American Samoa preliminary online fish inventory, which includes Samoan,
English and scientific names for most fish found in American Samoa (National Park
Service 2003). Rosia Tavita of FBNMS assisted with translations.

An interesting observation during the 2004 workshops in American Samoa was
that, of people asked, only one elderly woman in an outreach meeting in the village of
Fagasa, knew what the word ‘alititai (seafloor) meant. Most everyone else asked had
never heard the word before, although it is found in the Samoan Dictionary (Milner
1993). Most people asked in the independent nation of Samoa, not just elderly persons,
did know the definition of ‘alititai. Although not a scientific survey in any way, it does
point to the need for more availability of information in Samoan from a language-
preservation standpoint and to the changing use of words in American Samoa. Towards
this end, rather than assuming people know what it means, ‘alititai is now defined on the

website.
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Although it is not clear at the present time how the ASBTV will be used, due to
the current speed of Internet connections in American Samoa, most use for the time being
will probably be off-island. Eventually, the ASBTV, combined with educational modules
about marine GIS and coral reef conservation developed for American Samoa
Community College and work being done by the American Samoa Government
Department of Commerce, may lead to greater public awareness of the conservation
issues surrounding the reefs in American Samoa. It may also be a useful tool for
agencies and organizations, such as the American Samoa GIS Users’ Group, wishing to
conduct public outreach and facilitate more public participation in the process for
designation of marine protected areas. By providing a visual sense of what is actually out
in the deeper reefs around American Samoa, the site could be a starting point for

discussions about marine protected area designation held with the public.
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4. GIS Education and Local Data—Making GIS Interesting for Capacity Building

4.1 GIS Education for Capacity Building

Many jobs requiring GIS skills are not specifically GIS Analyst positions.
Resource management, public works, emergency management, land use planning and
public health are all fields in which someone may have a job where, for example, land
use planning is his or her primary responsibility, but the position may still require some
level of GIS skills (Britton 2000). The number of jobs requiring GIS skills outnumbers
the number of workers with GIS skills, even in developed countries, although developing
countries face far more serious shortages (Bishop et al. 2002). An important part of
meeting the needs of a GIS community is the training of students who will eventually
enter a GIS-related profession. Exposing students to positive experiences with GIS early
in their post-secondary education makes it more likely that they will be comfortable
taking advanced GIS classes and that they will go on to use GIS in their careers (Mueller
and Wickham 2003; West 2003).

An important key to local capacity building is local education and integration of
local GIS users into the GIS community. Introductory GIS classes in higher education
are where many GIS professionals began and this exposure to GIS can help provide a
knowledge base for a growing GIS community (Britton 2000, Deadman et al. 2000). GIS
can be a very powerful tool for science and geography education, providing a means to
develop critical thinking and analysis skills crucial to the scientific capacity-building
necessary for long-term local management of resources (Crosby et al. 2002, Green 2001;

West 2003). GIS can also help students become more comfortable with spatial
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representations of information (Biilmann 2001). Students who take a course including
basic GIS skills often become more comfortable, not only with GIS concepts and skills,
but using and working with computers in general, a skill that may also be in short supply
in a developing country. Although a student who takes an introductory course in GIS
may not continue on to a career in GIS, even the computer skills gained from the
experience can be of great value (West 2003).

Although a large body of literature exists describing how to design a GIS
curriculum for elementary and secondary schools, less has been written about introducing
GIS to students in higher education. Much of the existing literature on GIS in higher
education primarily deals with the design of an entire GIS program or the technological
challenges of starting a GIS program, rather than the design of the curriculum itself.
Another set of literature on GIS in higher education focuses more on how GIS education
fits in with traditional geography education (Kemp, et al. 1992). That being said, the
National Center for Geographic Information and Analysis (NCGIA) is an excellent
resource for GIS curriculum and course design in higher education. The website details
concepts that should be covered in a GIS curriculum and provides strategies for covering

them (NCGIA 2004).

4.2 Educational Modules for ASCC

4.2.1 General Strategies
One of the greatest challenges to GIS education is the availability of data and a

curriculum that makes use of local data. This is particularly true in remote areas, where
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data may not be accessible or, even exist at all. The use of data and lessons built around
areas with which students are familiar has been found to contribute to the success of a
GIS curriculum (O'Dea 2002). American Samoa is unique among the Pacific island
states in that it has been the focus of a number of marine surveys producing data that are
available free of charge. It also has an active GIS community, the American Samoa GIS
Users’ Group. The challenge has been to integrate that data into the local GIS
curriculum. Four educational modules were designed to introduce students to a variety of
GIS principles and skills using local data. The lessons, incorporating Ikonos satellite
imagery, multibeam sonar data, and ground-truth point data, are each designed to be
completed over a number of class periods. It was assumed, when writing the modules,
that students in the class would be at a beginner level with GIS software and concepts,
particularly with regard to raster data and operations.

The modules are designed around ArcGIS 8.x, the version of ESRI’s GIS
software installed at American Samoa Community College. They make heavy use of the
Spatial Analyst Extension, included with ArcGIS 8.x. The lessons focus on raster data,
the skills associated with working on raster data, and are designed to increase
progressively in complexity, giving students experience with a range of operations in
ArcGIS. Most introductory classes focus on vector data, so this set of modules focusing
on raster data will be a good supplement to a beginning GIS curriculum.

All lessons include several of the features described by Bishop et al (2002) as
being necessary in GIS educational modules. Each lesson specifically states the

objectives of the lesson and what skills and concepts with which students should be
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familiar on completion of the lesson. This gives students a sense of what to expect from
the lesson. Questions that require thought and feedback are included at the end of each
lesson as well. Students are also asked to do simple research on the Internet on their own
to find answers to certain questions, hopefully impressing on them the tie between GIS
and subjects that do not appear to be, at first glance, GIS related subjects. Some of the
modules point students to specific sites, while others require students to search for
information using a search engine such as Google. As noted earlier, although a dynamic
site such as the ASBTV does work very well in American Samoa, static web pages load
in a reasonable length of time, making Internet research feasible. This will also force
students to draw their own conclusions about what they have learned.

There are a number of concepts outlined by NCGIA (2004) as being necessary for
a core GIS curriculum that are covered by the educational modules. Per NCGIA
standards for community college and technical programs, the educational modules focus
on the application of GIS skills, the concepts behind those applications, and teaching GIS
concepts with real-world problems. The initial lesson introduces students to very basic
operations. These include many of the spatial analysis operations used in the second and
third lessons. The lessons also include application of GIS to a real-world problem which
is included in the NCGIA standards (2004).

The modules were designed to help students navigate through the complex
ArcGIS software. File names have been simplified so they are as intuitive as possible.
They follow a consistent format when introducing new tools, functions, and commands,

which will hopefully minimize confusions on the students’ part. When new tools and
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buttons are introduced, an

Loading the data
1. Open ArcMap. Click th@dd data button (or go

image of the tool is included in
to File -> Add Data).

Figure 4.1—Making GIS easier to learn, part 1. Pictures the text to help students find
of buttons and tools are included in the text of the

modules to help students find their way around the the appropriate button (Figure
software.

4.1). Hall-Wallace and McAuliffe (2002) noted that including pictures directly in the
instructions helped students navigate GIS software. Another solution to make software

navigation easier concerns pull-down menus. When
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bk oo the kg VbW a command is buried in a pull-down menu, the

k.50 0 Ruert. 9 Duin Frame instructions show all of the steps involved in finding

b. Add the bathymetry file and the coas
new data frame just as you did earlied  that command (Figure 4.2). Screenshots are included

Figure 4.2—Making GIS easier to

learn, part 2. Pull-down menu in all of the modules, particularly of dialog boxes and

commands are explained with a by

using the arrow indicating the next

menu or command.

wizards. The pictures of where things are make
elaborate explanations in the instructions less necessary and make the instructions less
confusing. In some cases, the expected results are also shown so students do not get lost

and discover the next step will not work with their erroneous result.

4.2.2 Specific Lesson Descriptions

The entire educational modules are included in Appendix C. The first lesson
introduces students to working with data in ArcMap and reading metadata in ArcCatalog.
This lesson relies heavily on Ikonos imagery because the representation of geographic
space is more intuitive in high-resolution Satellite imagery than in a bathymetry grid,
introduced later in the lesson, or in a digital elevation model (DEM). Students are asked

to look at various terrestrial and marine features around the island of Tutuila and to use
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simple GIS tools such as measure and identify. Students will compare the water quality,
which is evident from the image, in various bays around the island. Students are also
asked to draw conclusions about why water quality differences exist between bays. The
second part of the lesson introduces students to a bathymetry grid of Pago Pago Harbor.
Students will have the opportunity to supplement their work in ArcGIS by using the
Internet to investigate the wreck of the Chehalis that can be seen on bathymetry grids of
Pago Pago Harbor. The final part of the lesson has students use the NPSA Fish Inventory
and the Internet to answer questions about some of the fish in American Samoa. On
completion of this lesson, students will be able to: add data to an ArcMap project,
measure objects in ArcMap, use the identify tool in ArcMap, make a simple layout,
explain what factors affect the quality of a remotely-sensed image, and briefly explain the
history of the Chehalis wreck and why it still poses a threat to PagoPago Harbor.

The second lesson introduces students to the Spatial Analyst extension of ArcGIS,
to the Benthic Terrain Modeler, and to benthic classifications. The Benthic Terrain
Modeler (BTM), an ArcGIS 8.x-based tool, was developed by the NOAA Coastal
Services Center using the methods of Lundblad (2004), to simplify the process of benthic
terrain classification (Rinehart et al. 2004). The tool includes a wizard interface,
removing the need for command-line input, making it far more accessible to the
beginning GIS user, especially those with little experience working in a command-line
input. One has the option of allowing the BTM to create all of the grids necessary for
benthic classifications. Most people using the BTM will probably use this option. The

other option allows the user to use preexisting grids to create benthic zone and structure
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classifications. This feature is particularly useful for the second educational module.
Students will create all of the necessary grids, such as standardized BPI, individually.
This will allow the students to learn how the BTM really works and understand the
processes behind it. Since the BTM has a wizard interface, students will not have to
grapple with command-line input and will be able to run classifications for both benthic
zones and structures (running benthic structures using command-line input is too difficult
for an introductory level class). Using the BTM also avoids the need for a full
installation of ArcInfo workstation, which is considerably more expensive than ArcGIS
Desktop and currently unavailable at ASCC.

The lesson uses bathymetry grids from Pago Pago Harbor from 2001. Students
are asked to create benthic zone and structure grids by going through a series of steps
including creation of slope, BPI grids, and standardized BPI grids. BPI and standardized
BPI grids are created through the raster calculator within Spatial Analyst. The final part
of the lesson is done using the BTM. Students will use pre-defined classification
dictionaries designed for the lesson—one for zones and one for structures. At the end of
this lesson, students should be able to add extensions to ArcMap, do a slope analysis,
define a slope analysis, use the raster calculator, define bathymetric position index, create
BPI grids, use the BTM to create benthic zone and structure classifications, and define
benthic zones and structures.

In the third lesson, students continue to work in Spatial Analyst, but they are also
introduced to 3D Analyst and ArcScene. Students create three-dimensional

representations of FBNMS. Several analyses are introduced in the lesson, including
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hillshade and viewshed analyses. This is the first lesson that students actually work with
vector data and use some of the functionality of ArcCatalog. Students are asked to create
a new shapefile and add points to it to complete the viewshed analysis. Students typically
enjoy working with three-dimensional visualizations and this proved to be no exception
at the workshops held in September, 2004 at ASCC. Questions were included in the
lesson to ensure that students realized that three-dimensional visualization does have a
purpose beyond simply creating pretty pictures. By the end of the third lesson, students
will be able to define hillshade and viewshed analyses, create a three-dimensional view of
a bathymetry grid, create a new shapefile and add data to it.

The final component, part of the third lesson, asks students to use ground-truth
points, do a buffer analysis, and use various web resources to delineate a new, imaginary
MPA in Fagaitua Bay. This section is meant as the capstone assignment for the modules.
Students are asked to think about all of the issues surrounding the creation of MPAs,
including how they affect local populations dependent on subsistence fishing, how to
approach local villages about an MPA, what types of regulations an MPA should have,
and the need to include diverse habitats within the MPA. These are complicated issues in
any natural resource management strategy and students will probably find this part of the
project to be fairly challenging. At the end of this part of module, students will have
developed a strategy for creating an imaginary MPA and produced a short written
proposal for their MPA. Students will be required to include any maps they feel are

necessary to illustrate their proposal, so it will be a good demonstration of the technical
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GIS skills they have learned in the modules as well as a demonstration of their ability to

think through a complex problem.

4.3 Discussion

The educational modules attempt to address the idea of tying technical skills to
real-world concepts and problems that require more than technical skills alone to solve.
There are concerns that many GIS curricula teach excellent technical skills but do not
address how they should be applied to complex real-world problems, particularly in areas
where geographic information management is still fairly new (Dunn et al. 1999). The
project in the third lesson requiring students to design an MPA and develop strategies to
gain public support will help students understand that GIS underlies many planning
decisions, even when it is not patently obvious to an outside observer. Since decisions
made using a GIS have real world effects, hopefully, the students will gain an
understanding of how GIS can help make management and planning decisions, but also
how working with the public in the real world (i.e. not on a computer screen) can make
seemingly easy decisions much more complicated. This is certainly not just true in
American Samoa, but throughout the world.

The educational modules were presented as a short two-day workshop at
American Samoa Community College (ASCC) in September, 2004. The workshop was
attended by instructors at ASCC, government employees, and several students at ASCC.
The workshop was very successful and participants’ response to the workshop was
overwhelmingly positive. Both the GIS instructor and the marine science instructor at

ASCC expressed interest in using them in their classes, so forty student copies were left
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with them for use in their classes. Feedback was gathered and the modules were updated
to reflect some of the participants’ suggestions.

One unanticipated problem was that the computers at ASCC did not have ArcInfo
Workstation, which is necessary for the processing required to find benthic zones in the
second educational module. Workshop attendees completed all of the steps up to that
point and then the final step, the actual creation of benthic zones, was demonstrated on a
laptop with the necessary software. Participants felt that going through each of the steps
behind the creation of benthic zones was valuable enough that they would not want to see
the entire lesson done in the BTM. It has a wizard interface that allows creation of
benthic zone and structure grids without actually knowing how they are being calculated.
Given the way the BTM was designed, it was possible to re-design the lesson so students
still work through all of the steps up to classification and use the BTM to actually create
the benthic zone and structure classifications.

In addition to being used by the American Samoa Community College, the
modules could potentially be used by high school science or geography classes if they
have access to the appropriate software. Students at that level would be more than
capable of completing the modules as written. The ASBTV could also be used to help
introduce students to GIS concepts with some additional instruction. The modules have
already generated interest outside of American Samoa by instructors who want to
incorporate marine GIS into their lesson plans. The lessons are well-suited for use in any
introductory GIS class, as they present concepts that are important in any GIS

curriculum. While the other educational modules will have wider applicability outside
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American Samoa, the last part of the third module is specifically designed for American
Samoan students since students will address how to create an MPA in American Samoan
waters considering local conditions and problems. It might be easily adapted, however,
to other Pacific island nations with similar local concerns and challenges to creating
parks and reserves.

Many GIS users, particularly in developing countries, are self-taught and are not
able or willing to take a term or more away from their jobs to pursue a degree or even a
class in GIS (Gould 2001). Gould (2001) argues that short training courses offered by
academic institutions or self-directed lessons are potential solutions to this problem. It
may be easier for GIS users to spend a week or two away from their jobs or even to
persuade their employers to pay for a short course than it would be for them to take a
class that lasts an entire term. The educational modules developed as part of this project
were easily adapted to a short-course format with few changes. The only part of the
educational modules that did not work as well in a short format was the marine protected
area project, but with more planning, this could be adapted to a workshop format as well.
Working in groups on different aspects of a proposal, workshop participants could
develop a proposal in a much shorter amount of time than a student in a typical semester-
long introductory GIS class. Alternatively, the educational modules produced as part of
this project could stand alone as self-paced tutorials. Often people self-taught in GIS
have significant gaps in their knowledge (Gould 2001) that these modules might address,

particularly if the gaps happen to be in working with raster data.
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A common problem when writing any kind of documentation or lessons for a
particular version of software is that, inevitably, it is out of date before or soon after it is
completed. This has turned out to be the case with the educational modules. Although
currently, ASCC is using ArcGIS 8.x in their computer labs, ArcGIS 9 was released in
June, 2004. Much of the way the software handles raster data has not changed with the
new version and only a small portion of the modules focus on vector analyses, so few
changes are needed. The BTM is currently designed for Arc 8.x, but updates are in
progress to facilitate smooth operation in Arc 9.

To reach the widest audience, the modules will be distributed in several ways.
First, a number of traditional bound paper copies were distributed in American Samoa in
September, 2004. Each person attending the workshops received a teachers’ edition of
the educational modules which included a data CD with all of the data for the modules,
electronic copies of the modules themselves, supplemental PowerPoint presentations, and
answer sheets. The modules will also be available electronically on the Internet, from an
information page on the ASBTV. The module files will be converted to PDF files and
compressed together with the answer sheets and the necessary data layers in .zip files.
Environmental Systems Research Institute (ESRI) also maintains an archive of GIS
educational modules as part of their web pages. The archive is searchable by software
and by subject, making it both a good source for lesson plans and a good distribution
point for educational modules. The modules may be archived there as well. This will
allow more educators to access the modules than those who originally receive the paper

copies.
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S. Conclusions

This project has taken a multi-pronged approach to increasing public knowledge
about the coral reefs and benthic terrain in American Samoa. The creation of benthic
zone and structure maps for two nearshore areas around Tutuila will provide managers
with a better understanding of the areas they regulate and protect. The ASBTV and O le
‘Alititai o Amerika Samoa, in combination with the American Samoa Coastal and Marine
Bibliographic Database, provide the public with access to marine GIS data, maps, and
marine-related literature.

Web-based GIS cannot solve all of the data access issues in American Samoa
simply because the technological infrastructure is not at a point where high-speed Internet
access is ubiquitous. Although every effort has been made to make the ASBTV load as
quickly as possible, even Internet-savvy users on particularly slow connections may
become frustrated and give up on the ASBTV. It is likely that it will be a few years
before Internet connections are fast enough to make the site usable by a wider audience.
For the time being, most of the use of the ASBTV will probably be off-island. The
American Samoa Coastal & Marine Bibliographic Database is an independent site,
however and works quite well in American Samoa.

Another limitation to web-based GIS is that a person must have a certain level of
computer literacy in order to effectively use it and some form of Internet access, even at
the most basic level. Traditional outreach and some instruction are necessary to make
more people feel comfortable with a web-based GIS. Even in areas where a large

percentage of the population has access to the Internet, it is unlikely a website will gain a
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wide audience without some significant form of advertising and traditional forms of
outreach. Without more traditional forms of outreach, many people would never be
reached by a web-based GIS, particularly those with less access to computer technology.
These are often the people most likely to still dependent on more traditional resources
and would be most affected by decisions to restrict fishing or create MPAs (Wong and
Chua 2001). If participatory structures are not already in place, data access alone will not
spark participation in decision processes (Tulloch and Shapiro 2003). In spite of these
challenges, the creation of the ASBTV is an important step toward making data available
to as many people as possible. Local-language translations of scientific information are
also extremely important to reaching as many people as possible. Although the majority
of American Samoans speak English, community outreach programs in villages are often
conducted in Samoan.

Educational modules designed for the upper secondary and community college
levels will help ensure that students are exposed to GIS being done locally. Educational
modules will contribute to the technical capacity building effort in American Samoa. By
tying GIS skills to real-world, local problems, it is hoped that students will be more
interested in the subject matter and may go on to take more advanced GIS classes,
possibly even leading to a career in GIS. The educational modules provide educators
with another resource through which they can reach students. As Internet speeds increase
in American Samoa, it may be useful to produce educational modules using the American

Samoa Benthic Terrain Viewer for the high schools.
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The combination of these three aspects of this project will increase the public’s
exposure to GIS in American Samoa and, ideally, increase the public’s knowledge of the
coral reefs in American Samoa. Web-based GIS, in combination with traditional
outreach and educational outreach can provide a well-rounded way to educate and inform
the public about research activities, providing a better connection between the public and
the scientific community. It also presents the opportunity to increase public awareness of
GIS use in a remote location. It is hoped that the use of the ASBTV may eventually lead
to some form of public participation GIS, but time will be required to determine if this is
the case and for local Internet connection speeds to catch up enough to make the site
more reliable and user-friendly. There should also be some effort to incorporate local
knowledge into the ASBTV, since this is important to the development of a participatory
process (Wong and Chua 2001).

Future work planned for American Samoa includes two submersible or ROV
dives, funded by the Hawaii Undersea Research Lab of the NOAA National Undersea
Research Program, to ground truth the classifications produced as part of this and
Lundblad’s (2004) project. It is hoped that a stronger link will be found between benthic
terrain and species or biological community types, particularly with regard to fish
species. Additionally, the American Samoa GIS User Group is in the process of starting
an ArcIMS website, which may mean that the ASBTV could be moved to Tutuila in the

near future.
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TABLE OF LAYERS ON THE ASBTV

Digital Elevation Model (DEM) of Tutuila

DEM of the Manu’a Islands

Fagaitua Bay Bathymetry

Fagaitua Bay Benthic Zones

Fagaitua Bay Benthic Structures

Fagatele Bay National Marine Sanctuary (FBNMS) Bathymetry
FBNMS Benthic Zones

FBNMS Benthic Structures

National Park of American Samoa (NPSA) Bathymetry
NPSA Benthic Zones

NPSA Benthic Structures

Vatia Bay Bathymetry

Vatia Bay Benthic Zones

Vatia Bay Benthic Structures

Pago Pago Harbor Bathymetry

Pago Pago Harbor Benthic Zones

Pago Pago Harbor Benthic Structures

Coconut Point Bathymetry

Coconut Point Benthic Zones

Coconut Point Benthic Structures

Taema Bank Bathymetry

Taema Bank Benthic Zones

Taema Bank Benthic Structures

Revelle Bathymetry Data

Roads for eastern Tutuila, Anunu’u and the Manu’a Islands
Villages

Counties




Appendix B—Identifying Raster Values in ArcIMS HTML Viewer

the ability to do an identify query on a raster layer requires editing several javascript files

Raster files can be displayed by an ArcIMS map service fairly easily. However,

and one HTML file.

1.

In the foc.htm file, some changes need to be made to make a radio button show next
to the layer name in the layer list. This allows users to make the raster layer active.
First, do a search for LayerlsFeature. This will go to the appropriate place in the
toc.htm file.

Delete the following code:

if (t.LayerIsFeature[i]) {

} else {

document.write('&nbsp;');

In the aimsldentify.js file, the existing identify needs to be edited and a new function
added to allow the identify function to work on raster files.

Change the //identify feature function to the following:

function identify(e) {
if (checkIfActivelLayerAvailable()) {

highlightedOne="";
var theX = mouseX;
var theY = mouseY;
getMapXY (theX,theY);

if (LayerIsFeature[ActiveLayerIndex]) {
searchTolerance = (xDistance/iWidth) * pixelTolerance;
var tempWest = mapX - searchTolerance;

var tempNorth = mapY + searchTolerance;

var tempEast = mapX + searchTolerance;

var tempSouth = mapY - searchTolerance;

var theString

writeGetFeatures (tempWest,tempSouth,tempEast,tempNorth);

showRetrieveData();
sendToServer (imsQueryURL, theString, identifyXMLMode) ;



} else {

var theString = writeGetPixelXML(ActiveLayer,mapX,mapY);

//alert("Identify:" +theString);
showRetrieveData();
sendToServer (imsURL,theString, identifyPixelXMLMode);

}

//if (useTextFrame) parent.TextFrame.document.location
"text.htm";

}
}

b. Add the following function directly before //function writeldentifyXML:

// New function to get pixel value
// mkd 10/22/02
function writeGetPixelXML(thelLayer,xClick,yClick) {
var theString = '<ARCXML version="1l.1"><REQUEST>\n';
theString += '<GET RASTER INFO x="'+xClick+'" y="'+yClick+'"
theString += 'layerid="'+theLayer+'" >';
theString += '</GET_RASTER_INFO>';
theString += '</REQUEST>';
theString += '</ARCXML>';

return theString;

}

In the aimsCustom.js file, a new variable has to be added and defined.

a. Add the following line under global variables, near the top of the file:

identifyPixelXMLMode = 1001;

\n';

b. Add the following function under function useCustomFunction(the Reply),

where it says insert code here

if (XMLMode==1001) {
// Response from pixel query
//alert ("aimsCustom:" +theReply);
var Winl = parent.TextFrame;
var theFrame = "parent.MapFrame";
Winl.document.open();

Winl.document.writeln('<html><meta http-equiv="Content-
Type" content="text/html; charset=' + charSet + '"><head><title>' +

titleList[7] + '</title></head>');
Winl.document.writeln( '<body bgcolor=""' +

textFrameBackColor + '" text="Black" link="Blue" vlink="Gray"

LEFTMARGIN=0 onload="window.focus()">"');
Winl.document.writeln( '<center>"');

Winl.document.writeln('<FONT FACE="Arial" SIZE="-1"><b>' +

LayerName[ActiveLayerIndex] + '</b></FONT>');



74

Winl.document.writeln( '<table border="1" cellspacing="0"
cellpadding="0" nowrap bgcolor="' + tableBackColor + '">');

var pixelValue = justGetFieldValue(theReply, "value",1);
Winl.document.writeln( '<tr><td>Value=</td><td>'+pixelValue+'</td></t
r>");

Winl.document.writeln('</table>"');
!/ displayAttributeData(theReply);

c. Inthe aimsXML.js file, add the following to the global variables:
var identifyPixelXMLMode = 1001;
d. In the aimsLayers.js file, change line 57 to look like this:

if (LayerIsFeature[i]) { setLayerFields(i); }
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Appendix C—American Samoa Marine Data GIS Education Modules

American Samoa Marine
Data GIS Education
Modules

Emily M. Larkin and Dawn Wright,
Oregon State University
September, 2004
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Exploring the reefs

Introduction

Coral reefs surround many of the islands in the Samoan Archipelago. Many people
depend on the reefs for fish, shellfish, etc. Coral reefs depend on clear, unpolluted water
for survival. They face a number of threats from various problems such as pollution,
sedimentation, destructive fishing methods and global climate change.

Until recently, little was known about the coral reefs in American Samoa below the point
to which humans can dive. In 2001 and 2002, seven areas around Tutuila were surveyed
between 2 m and 150 m in depth).

In this lesson, you will explore portions of the reefs around Tutuila using two types of
remotely sensed imagery. One type is obtained from space with a satellite (electro-
magnetic energy) and the other is obtained at sea with a multibeam bathymetric mapping
system (acoustic energy). Satellite imagery, in clear water, can penetrate the ocean down
to 30 m. The images you will be working with were obtained using the Ikonos satellite.

Objectives
On completion of this lesson, you should be able to:

* Add data to an ArcMap project.

* Define metadata and explain its use.

* Change the symbology for a layer.

* Measure objects in an ArcMap project.

* Identify features in an ArcMap project.

* Make a layout.

* Explain what factors affect the quality of a
satellite image.

Symbology—how ArcMap
draws a /ayer in a project.

Layer—the reference, in
ArcMap, to a data set.

Working with the Data

Ikonos imagery is obtained from the Ikonos satellite. The colors of the imagery are
separated into bands (the imagery you will be looking at has 3 bands that appear in
ArcGIS: red, blue and green). The red band does not penetrate water very well, but the
blue and green bands can penetrate ocean water up to 30 meters in good conditions.
Water clarity, pollution and waves can all affect how deep the imagery can detect. Color
Ikonos images have a resolution of 4 meters.

Loading the data
1. Open ArcMap. Click the */add data button (or go to File -> Add Data).
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2. Navigate to the directory where the data are stored. To do this you will likely have to
click on the connect-to-folder@ button. Choose the correct folder and click Ok.

3. Choose the file named tut_color16.img and click ok. It may take it a few minutes to

load...be patient.
Exploring the data—Ikonos

1. Metadata: To find more information about the
Ikonos image of Tutuila, you need to look at the
metadata. Metadata is basically a file that tells more
information about a GIS data file. Some information
that may be contained in a metadata file includes
date the information was obtained, resolution,
projection, geographic coordinates and where the
data originated. Without metadata, many files would
not be useful.

Open ArcCatalog and navigate to where the image is
stored. Click once on the file tut_color16.img on left
hand side of the window. Now click on the Metadata
tab above the right side (Figure 1). There are three
tabs shown in the metadata: Description, Spatial and
Attributes. Be sure to click on each one or you will
miss some information.

a. What is the resolution of the image (hint: itisa
multi-spectral image)?

b. How many original images were tiled (pieced
together) to produce the image of Tutuila?

c. Who created the image?

d. When was it created?

<3 ArcCatalog - Arcnfo - T:\GeoScience\ShiverMeTimbers\arki

File Edt View Go Tools Window Help

(- B & X & Q90O N

Location: | T:\GeoScience\ShiveiMeTimbers\larkine\Modules\Modules_dal

erp ~
hanej
ac

Figure I—The metadata tab in
ArcCatalog

Note: ArcCatalogis a
program that allows you to
manage your GIS data files.
Since each shapefile and
raster grid is actually a group
of files, it is never a good
idea to move or rename files
in Windows Explorer. These
types of things can be done
in the same way in
ArcCatalog and should
always be done in
ArcCatalog.

2. Go back to ArcMap. Zoom in to Pago Pago International Airport using the & zoom
in tool. Click on the zoom in tool. Now, while holding the mouse button down on the
map, draw a box around the area you want to see in more detail. Using the measure

£

tool, find the length of the longer runway at the airport. Click on the measure tool == ,
then click on one end of the runway and double-click on the other end. The length of
the runway will be shown in the lower left corner of the ArcMap window:

I y =

=TT =0
Segment: 1246.718819 Total: 32727.911928 Meters




a. What is the length of the long
runway at Pago Pago Note on Buttons and Tools: There is a difference
International Airport? between a button and a tool in ArcMap. When

b. What is the length of the long you click on a button, something happens without

runway at Pago Pago any other action on your part. For example, when

. . . . +
International Airport in feet? you clicked on the 2 add data button, a file
window appeared. There is also a zoom in button:

1) Right Click on

E N
7. The button zooms in on the map when it is

Lgyers—)P roperties. clicked. When you click a tool, however, nothing
2) Click on the General tab happens until you do something on the map. The

and change the Display @

pulldown menu to show zoom in fool —— requires you to click on the map

feet and draw a box before it will zoom in closer on

the map.

3) Change the display back to

meters once you have the
answer.

3. Ikonos imagery can penetrate the ocean down to
30 m in clear, smooth water. Zoom in to Fagaitua
Bay on the southeast side of Tutuila (Figure 2). / 0

(The Full Extent ' ® button can be used to zoom out
to the entire island). The water in this image Fagaitua Bay
appears dark. Notice the dark triangle-shaped area

in the shallow part of the reef. This area was Figure 2—Fagaiuta Bay.
dredged at one time and has since been re-colonized
by coral.

a. What are the white blotches around the shallow parts of the reef?
b. How many channels (ava) leading from the shallow part of the reef out to sea can
be seen in Fagaitua Bay?

4. Zoom in to Fagatele Bay (Figure 3) on the
southwest end of Tutuila. O

c. Why isn’t this part of the image as useful
. . Fagatel
for looking at the seafloor as the image of Bay —W
Fagaitua Bay?

Figure 3—Fagatele Bay.

d. What is causing the water to be less transparent than the water in Fagaitua Bay?

Zoom in to Pala Lagoon (just north of Pago Pago Airport).

e. Why is the water in the lagoon red?
f.  Would you expect to find coral here? Why or why not?



Turn off the Ikonos image of Tutuila by clicking in the check box

next to the layer name.
Exploring multibeam bathymetry

Bathymetry is the underwater version of topography. A

bathymetry grid is made up of cells, each with a value equivalent
to the depth of the ocean at that point (Figure 4). The real-world

1813
21917
4 1716

Figure 4—A
sample grid
showing
depth values.

distance covered by one side of a pixel is the resolution of the grid.

For example, the grid you will be working with today has a resolution of 5 m. That

means that each side of a square pixel in the grid is equivalent to 5 m on the ground.
Multibeam bathymetry can be used for depths of a just a few meters to over 1000 m.

Multibeam surveys works similar to a fish finder. A pulse
of sound is bounced off of the ocean floor and the time it
takes to return to the ship is measured. In general, the
longer it takes for the sound pulse to return, the deeper the
ocean is at that point. The resolution of the multibeam
bathymetry grid used in this lesson is 5 meters, but in later
lessons, bathymetry grids with resolutions of 1 meter will
be used. Unlike satellite imagery, multibeam sonar is not
a picture of the seafloor. It starts out as simply a
collection of return times for the sound pulses. It is then
processed to produce a bathymetry grid, a collection of
depth values for the ocean floor.

= g Layers
= [ppEs——adn
Copy

X Remove

l [E Open Attribute Table

= Fri

L

Joins and Relates »

Q Zaoom To Raster Resolution

Visible Scale Range 3
S T d

u
™ Save As Layer File...

BE' Properties. ..
- O an

Figure 5—Zoom to Layer.

1. Add pago_bathy and AmSam_cst to your project (see p. 1 to remember how to do
this). Right click on ppg5m84 neg in the Table of Contents (Figure 5). Choose Zoom to

Layer from the options.

2. Changing layer display: Right click on pago_bathy
in the layer list again. This time choose Properties
(Figure 6). Click on the Symbology tab (Figure 7). For
this layer, the most appropriate way to display the
information is Stretched, which should already be
chosen. The color of the display can be changed in the
Color Ramp box. Choose the color bar that goes from
red to blue. Bathymetry is often shown using one that
starts with red for shallow areas and ends with blue for
deep areas. If the color bar is reversed (red for deep
values), check the Invert box.

x

- £ Layers

- e —

\ 48 Copy

F X Remove
. L M Open Attribute Table

= M fua Joins and Relates »

: <& Zoom To Layer
@ Zoom To Raster Resolution
i bt ¢ Visible Scale Range »
F
|

R
mmc  SaveAslayerFie...
o e
= Mo

Figure 6—Accessing the
Properties window.
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Layer Properties R 1].’9
General | Source | Extent | Display  Symbology IFieids | Joins & Relates |
Show:
Unique Values ‘ Draw raster stretching values along a color ramp
Classified
Color Value Label
75 |High: 75
£ Low: 6
cots o, [ i L
e G
| Type: |Standard Deviations _‘J Histogram... |
| |
|

|
i n 2 I Invert
‘ i

Display NoData as vI

I~ Display Background Value: 0 as 'I

Cancel I Apply

0K I
Figure 7—The Symbology tab. 7
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3. Exploring the multibeam

data. The Identify tool 9 can
be used to learn more
information about an area.
First, make sure the
pago_bathy layer is active. Do
this by clicking on the name of
the layer once, so that it is
highlighted. Now click on the
Identify tool and click
somewhere on the pago_bathy
grid. The Identify Results
window will appear with
information about where you
clicked in it. The pixel value in
the Identify Results window
shows how deep the place

where you clicked is, in meters. Click on different areas to compare depth values in

different parts of the harbor.

4. Another way to learn more about a grid is to look at the statistics for it. Right-click on
the name of the Pago Pago Harbor grid and go to Properties. Click on the Symbology

tab if it is not showing. Click on the Histogram button . This will bring up

the Histogram window.

a. What is the maximum depth in Pago Pago Harbor?

b. What is the mean depth in Pago Pago Harbor?

5. Zoom in to the northern

half of Pago Pago Harbor.

The World War II tanker,
Chehalis, sunk in Pago Pago
Harbor in 1949. This wreck is
visible from the multibeam
bathymetry. Zoom in to the
area circled

along the south side of Pago
Pago Harbor (Figure 8).

Zoom in close enough that you
can see all three features. The

long straight feature is the
wreck of the Chehalis.

Figure 8—The wreck of the Chehalis.
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Visit the following web pages to answer questions c-e:
http://www.history.navy.mil/danfs/c7/chehalis.htm and http://dusk.geo.orst.edu/esri02/.

Making a Layout = B ppgSma4_neq
Printing maps from ArcMap requires making a layout.

1.

How long is the wreck, in meters?

How deep is the wreck?

How did the Chehalis sink?

What was she carrying?

Is the Chehalis still a concern for pollution in the harbor? Why? (hint: think
about what the ship was carrying).

o0 o

- £¢ New Data Frame

Value
M High : 6

M Low : -75
= g N _cst_nad
Zoom out so the map shows all of Pago Pago Harbor. - t_nads3

Add the AmSam_cst layer. This is a polygon shapefile
showing the coast of American Samoa. You can change  Figure 9—Changing the
the fill color by clicking on the color under the layer color of a layer.

name in the layer list (Figure 9).

Go to File = Page Setup and change the page orientation to Landscape. Make sure
the page size is 11 x 8.5. Click on the layout button in the lower left hand corner of
the map frame (Figure 10). The map frame will change to show a piece of paper and
the part of your map that was visible in the map frame. Note: A new toolbar will

@& EE W %
appear in the layout view: the layout toolbar. e o= If you

want to zoom in or move around on the /ayout, it is important to use this toolbar,
rather than the map toolbar. If you use the map toolbar, your layout will change in
unexpected ways.

It is common to include an inset map to show a more
general location of the map. To do this, go back to the

map view.

a. Go to Insert > Data Frame. ﬁﬁ
Daply | Sosce |

b. Add the bathymetry file and the coast file to the i Ml

new data frame just as you did earlier. Zoom in to
the Tutuila. You may want to change the colors of
both files, which is also done just as you did
earlier.

Figure 10—The Layout
button.



c. After you are happy with the colors, go
back to the Layout View. There will be
two maps there now, although they
may be on top of each other. Click on
the map of Tutuila and move it to the
upper right or left corner of the page.

Note: The faint line around the edge
of the page shows where the
printable area is. Do not put
anything outside of this line or it will
be cut off by the printer.
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d. Place the map of Pago Pago Harbor where you would like it. You can change the
size of the image by clicking on a corner and dragging it larger or smaller.

e. Place the map of Pago Pago Harbor where you would like it. You can change the
size of the image by clicking on a corner and dragging it larger or smaller.

f. Place the map of Pago Pago Harbor where you would like it. You can change the
size of the image by clicking on a corner and dragging it larger or smaller.

4. There are a number of important things that should be included on a map:

a. Title

b. Your Name Note on Text Size: The title should be the

c. Date largest text in your layout. Your name and

d. North Arrow date should be smaller and less prominent.

e. Scale Bar The north arrow gnd scale bars should be large
f Neatline enough to be easily read.

g. Legend

5. The processes to add a title, name and date are all similar.

a. Go to Insert = Title. A text box will appear on the map. Type your title in the

box. It probably is not a font and size that looks good, so click off of the text box.
To edit the style of the text, double-click on the text or right-click

and choose Properties. A window will appear with various options. You can

edit the text itself in the box under the Text tab.

i. Click on the Change Symbol button to change the style of the text. This will
bring up the Symbol Selector window with various font options. On the right

side of the window is a box labeled Options. You can change the font, font

size and appearance here. When you are done, click Ok.

ii. One other thing you may want to change is the justification of the text. This is

how the text is aligned: left, right or center. This is done in the Properties

window just under the text box.

iii. To move the Title, click once on the text. Arrows will appear; click and drag

the text to where you want it.




6.

10.

11.
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b. To add your name and .the date, go to Insert e PIx)]
- Text. A text box will appear and can be Scal and s | Numbers and Msks | Fomat|
edited and moved in the same way that you — e
made changes to the title. e T T
Number of subdivisions ria
To add a North AITOW, g0 to Insert = North IV Show one division before zer0
Arrow. The North Arrow Selector window will e -
appear. Pick one that suits you and click Ok. The Unis
North Arrow can be moved in the same way that bmicbm B S
. {Melels 3
you moved text. To change the size of the North Label Posion
Arrow, click on one of the corners and drag it to Joer labols R
make it bigger or smaller. o — el
Gap: W
To add a Scale Bar, go to Insert = Scale Bar. e || ;

The Scale Bar Selector window will appear.
Choose a scale bar style and click the Properties
button, making the Scale Bar window appear.
Make sure the units are in something that makes sense, such as meters, kilometers or
miles and click Ok (Figure 11). Click Ok again. The scale bar can be moved in the
same way text is moved. To resize it, click on one of the handles and drag it to a new
size.

Figure 11—Changing the scale
bar units.

Adding a neatline: Go to Insert-> Neatline. The Neat/ine window will appear.
Choose the Place Inside Margins option. In the Borders pulldown menu, choose a
neatline that you like. In the Background pulldown menu, choose Hollow (meaning
“No Fill”). Click Ok.

The last thing you need to add is a legend. Make sure your map data frame is
activated, NOT the inset map (To activate a data frame, right-click on it and choose
Activate.). Go to Insert->Legend. The Legend
Wizard will appear. Click Next twice. Click Ok Note: You can edit your
again. The scale bar can be moved in the same way legend after it appears by
text is moved. To resize it, click on one of the r1ght-ghck1ng on it and
handles and drag it to a new size. choosing Properties.

Adding a neatline: Go to Insert-> Neatline. The Neat/ine window will appear.
Choose the Place Inside Margins option. In the Borders pulldown menu, choose a
neatline that you like. In the Background pulldown menu, choose Hollow (meaning
“No Fill”). Click Ok.

The last thing you need to add is a legend. Make sure your map data frame is
activated, NOT the inset map (To activate a data frame, right-click on it and choose
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Activate.). Go to Insert->Legend. The Legend Wizard will appear. Click Next

twice.
a. On the Border Options screen, choose a border you like from the pulldown
menu.

b. Click Next twice and the click Finish.

c. The legend will probably appear in an odd place such as directly over your map.
It can be moved around and resized in the same manner as text or the north
arrow.

12. Make sure everything on the map lies within the neatline (i.e. nothing touches or falls
outside the neatline.). When you are happy with the map, print a copy to turn in.

National Park of American Samoa Fish Inventory

Go to the National Park of American Samoa Fish Inventory
(http://www.nps.gov/npsa/NPSAfish/). Choose to different species of fish and answer
the following questions about them. You may need to search for their scientific, English
or Samoan names on Google and look at a several sites to find out more about them.

What are the scientific, English and Samoan names for the fish you chose?
Where do they live? (on the reef? deep ocean?)

What type of habitat do they prefer? (under rocks? open water?)

What do they eat?

Are they fish that you have seen, either in the water, at the market, or a fish you
have eaten?

6. Are they threatened species? If so, why are they threatened and what is being
done about it?

MRS

Additional Questions

1. If a satellite image has a resolution of 5 m, would it
be possible to tell apart two cars parked next to each
other (about 1.5 m apart)? Why or why not?

2. What is the coarsest resolution imagery that could
be used to distinguish features that are 20 m apart?

What to turn in: % st
Figure 12—A fish in National
1. Answers to the questions. Park of American Samoa.

2. Your layout from the second part of the lab. (Photo by E. Larkin).
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Benthic Classifications

Introduction

In this lesson, you will learn how to work with bathymetry to get a better understanding
of what the ocean floor looks like. You will learn how to work with the raster calculator
and how to work with ArcInfo GRID. Please keep in mind, in this lesson, typing
accurately is very important.

Objectives
At the end of this lesson, you will be able to:

* Do a slope analysis.

* Use Raster Calculator to do simple analyses.

* Use the Benthic Terrain Modeler to create benthic zone and structure grids.

* Define: Slope, Bathymetric Position Index, benthic, standard deviation,
classification dictionary and benthic zones.

Slope Angle
The first analysis you will do is a slope analysis for Pago (Degree)
Pago Harbor. Slope is a measure of the steepness of the Rise
landscape. Areas with a greater degree of slope are
steeper. Slope is calculated based on elevation (on land) or
. . Run
depth (under water) values. Slope is calculateq in one of Figure 13—Percent
two ways: degree of slope or percent slope (Figure 13). slope = Rise +~ Run
*100. Degree slope
1. Start ArcMap with a New Empty Map and add the equals the Slope Angle.
(after ESRI 2004).

pago_bathy grid to your project.

3. Make sure Spatial Analyst is turned on by going to Tools=>Extensions and checking
the box next to Spatial Analyst. If the Spatial Analyst toolbar does not show up, go to
View->Toolbars->Spatial Analyst.

21l 2. Add the Benthic Terrain Modeler toolbar by going
Input suface: pago_bathy -] @| to Spatial Analyst > Surface Analysis=>Slope. This
C Percent will bring up the Slope dialog box (Figure 14).

Output measurement: ' Degies

Z factor: 1

4936736634

a. Make sure the pago_bathy grid is showing in the
@| Input Surface field.

Output cell size:

Output raster:

Figure 14—The slope window. b. Leave the Output Measurement as Degree.



C.

Change the Z factor value to match the value in the
Output cell size field. Click on the folder next to the
Output Raster field and give a name to the file that
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Note: Remember,
filenames must be less
than 13 characters.

will be created.

The second part of the
process will be to calculate
Bathymetric Position Index.
BPI determines where each
pixel is in relationship to the
pixels around it (Figure 15).
The results of the BPI will
give a better picture of what
type of features are on the
seafloor.

You will be working with a 5
meter grid of Pago Pago
Harbor. BPI isolates features
of a certain size, chosen by
the user. In this case, you
will look at small features
and large features, so BPI
will be calculated twice.
Broad-scale BPI refers to
large features and fine-scale
BPI refers to small features.

pt=p=tpi= 0 (ridge)

#— Elevation at point pt
44— Mean Elevation neighborhood p

pt<i =tpi <0 (vallev)

..ij. a— Mean Elevation neighborhood 1L
#—Elevation at pomt pt

pt = p = tpi = 0 {constant slope, flat area, or saddle)
Check slope of the point
Flat
Slope Mean Elevation in neighborhood 11

Mean Elevation in

Neighborhood p \\‘
#’_* " E—

\ *

Elevation at point pt Elevation at point pt

Figure 15--Bathymetric Position Index (after Weiss 2001)

The general form of the equation you will use is:

BPI<scalefactor> = int((bathymetry — focalmean(bathymetry, annulus, irad, orad)) + .5)

Scalefactor = is the map units of the outer radius multiplied by the resolution of the grid.
In this case, if we wanted a scalefactor of 100, meaning we are interested in
features around 100 meters in size, we would use an outer radius of 20 (5 m

resolution * 20 = 100).

Bathymetry = this is the name of the bathymetry grid, pago_bathy, in this case.

Annulus = this is the shape of the area that Spatial Analyst will use to calculate BPI.

Spatial Analyst can use a number of shapes, including a circle and an annulus, which is

shaped like a donut.

irad = this is the inner radius of the annulus.
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orad = this is the outer radius of M Raster Calculator ? X

1.

2.

the annulus. e
[ppgSmB4_neg (& o
Go to Spatial Analyst > g | 2ol s] -] ol
Raster Calculator. / I _4J 5} 6 i ;} _>=J ﬂ

The name of the bathymetry _j _1_l i;l —3J ‘(_J e ﬁ}

grid should be listed in the
upper left in the raster _‘} 0 z_; Li J ﬂ]

calculator (Figure 16).

a.

C.

Double-clicking on the
name of the bathymetry
grid will make it appear
in the bottom box. To do
anything with it, you will
have to type in Figure 16—The Raster Calculator.
commands to tell spatial

analyst what to do. For now, make sure the bottom box is empty.

About Building Expressions i | Evaluate l Cancel ! > J

First, we will calculate broad-scale BPI: Type the following commands into the
bottom box of the raster calculator. NOTE: 1t is extremely important to type
things into the raster calculator exactly as shown. Spaces matter!!!

int(([pago_bathy] — focalmean ([pago_bathy], annulus, 5, 40)) + .5)

i. Be patient! This may take a few minutes.

ii. When it is finished, right click on the new layer and choose Make Permanent.
Important: Save your grid in the same folder that contains the bathymetry
and slope grids.

iii. Rename the title of the layer by right-clicking on the name of the layer and
choosing Properties. Click on the General tab and rename the file pago_200.

iv. Create a layout showing broad-scale BPI. Be sure to include an inset map,
title, name, date, north arrow, and scale bar.

Now, calculate fine-scale BPI. A slightly different equation is used for this
because you will use a circle instead of an annulus to calculate BPI. When using
a circle, spatial analyst automatically assumes and inner radius of 1, so you do not
have to define the inner radius. Open the Raster Calculator again. Type the
following equation into the raster calculator as you did before:

int(([pago_bathy] — focalmean ([pago_bathy], circle, 2)) + .5)
i. Make the new grid permanent and rename it pago_10 (10 for the scale factor).

Important: Save your grid in the same folder that contains the bathymetry
and slope grids.



ii. Create a layout showing fine-scale BPI.

3. Now the BPI grids must be standardized to the same scale.
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a. The first thing you will need to do is find out the mean and standard deviation for

each of the BPI grids.
Layer Properties ? m
General | Source | Extent | Display Symbology | Fields | Joins & Fielates |
Show:
U Values Draw raster grouping values into classes
Stretched Fields Classification
Value: PR | Equal l

Normalization: | ¢None> v Classes: |9

[ Label | ~
[ 346 - 2229939989 346 - 2228889889
I 2229988999 - -99.77777778 -222.8898888 - 9977777778
B 9977777778 - 2333333333 9977777777 - 23.33333333
B 2333333333 - 146.4444444  23.33333334 - 146.4444444
] 146.4444444 - 2695555556 146.4444445 - 2695555556
‘ 5 2695555556 - 392.6666667 2695555557 - 332 6666667
3926666667 - 515.7777778  392.6666668 - 515.7777778
[ 15157777778 - 638.8898889  515.7777779 - 638.8886889 !

I Show class breaks using cell values Display NoData as -

0K | Concel | |

Fig'itre 17—The classify button in the symbology
window.

Classification

Classification

Method: >
Classes: |9 v
Data Exclusion 124333
; Mean 0.752743150
r Exclusion .. Standard Deviation: 9968787226,
- __sorwing._|
Samping ...
- ampling
Columns: 100 =] I~ ShowStd Dev. |~ Show Mean Break Values _’/_J
g FE 8 I & B E B -222.8888883
eoooor B K & ¥ B & E g g 3977777778
e E g 3 B g K| g =& 2333333333
1 8 g o ¢ 2 8 g 8 146.4444444
0000 &l @ IR F & & B © 269 555556
392 BEBEGET
40000 5157777778
6388888889
30000
20000
10000
0
-346 -69 208 485 762 e
- e Cancel

Figure 18—The statistics necessary to standardize
BPI grids.

ii.

iil.

1v.

Right click on the fine-
scale BPI grid and choose
Properties
In the Symbology tab,
click of the Classify
button (Figure 17).
A new window will
appear. In the upper right
corner, you will find the
mean and standard
deviation values. Write
these down, all of the
digits, for use a little later
(Figure 18).
Close the Classification
Window and the Properties
window.

v. Do the same for the

broad-scale BPI.

b. The general equation you will use to standardize the BPI grids is:

int(((([BPI] - mean) | standard_deviation) * 100) + .5)

So, if an example grid, named bpi_test, has a mean of 3.25 and a standard

deviation of 2.25, the equation would look like:



&9

int(((([bpi_test] — 3.25) / 2.25) * 100) + .5)
i. In Raster Calculator, type the above equation using the mean and standard
deviations from your fine-scale BPI grid.
ii. Replace [BPI] with the name of your fine-scale BPI grid.
iii. Click the calculate button.
iv. When ArcMap is finished making the new grid, make it permanent and name it
ppgfine_std. Important: Save your grid in the same folder that contains the
bathymetry and slope grids.

v. Repeat these steps for the broad-scale BPI.

c. Save your project and exit ArcMap.

Benthic Zones and Structures

Now you will actually calculate benthic zones and structures. Benthic zones are broad
classifications of the landforms on the ocean floor. Benthic structures are finer, more
detailed classifications of the landforms on the ocean floor. Benthic zones and structures
are calculated using an extension called the Benthic Terrain Modeler. This tool will use
the slope and BPI grids you created to classify the seafloor into zones and structures.

1.

Add the Benthic Terrain Modeler Toolbar the same way you added the Spatial
Analyst foolbar earlier in this lesson.

Click on the Benthic Terrain Modeler Menu and choose Benthic Terrain Modeler
Wizard. Read the first screen and click next.

First, set your working directory. Setting the working directory tells the Benthic
Terrain Modeler where to look for files and where to save files. Set your workspace
by:

a. Clicking on the folder next to the First, select working directory field and
browsing to where your slope and BPI grids are stored OR
b. Typing in the full path of that folder in that field.

Click the circle next to Use previously created...(Figure 19). Input the names of the
standardized BPI grids into the correct fields. Input the name of the bathymetric grid
(pago_bathy) into the correct field.

Click Next.



w. Benthic Terrain Modeler

Benthic Terrain Classification Setup

=

First, select working directory:
lG:\ModuIes\Modules_data

Input Data
Next, select one of the following two options:

¢~ Run an entire zonal dlassification session. Please
specify input bathymetric data set,

Broad Scale: |

Bathymetric Grid: |

Figure 19—The first screen of the Benthic
Terrain Modeler.

10.
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The next screen is the Classification
Dictionary screen. You want to use an
existing dictionary. Browse to the file
AmSamoa_zones.xml. This dictionary
tells the Benthic Terrain Modeler how to
classify the grids into benthic zones. Click
Next.

Make sure all the file names for BPI and
bathymetric grids are correct. Also make
sure it is using the correct classification
dictionary.

Change the output data set name to
pago_zones. Click Finish.

To create a benthic structure grid, repeat
steps 3-5.

In the Classification Dictionary screen, set
the classification dictionary to
AmSamoa_structures.xml. Click Next.

11. Make sure all the file names for BPI and bathymetric grids are correct. Also make
sure it is using the correct classification dictionary.

12. Change the output data set name to pago_struct. Click Finish.

Questions:

1. What is the scalefactor of the broad-scale BPI you calculated (refer to page 1 for
how to calculate scalefactor)? Show your work.

2. Calculate the following for BPI. Show your work:

a. If you want a scalefactor of 400 and your grid resolution is 10 m, what
outer radius should you use?
b. Ifyou are using an outer radius of 16 and the grid resolution is 5 m, what
is the scalefactor of the BP1?

3. What is the definition of standard deviation (look this up in a dictionary or on the
internet)? What percentage of values lies within one standard deviation of a

mean?
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4. If you had the opportunity to take a submersible down in the bay, what areas
would you like to see? Remember, some of the more complex areas may be areas
that have more diverse fish and coral communities. Mark the areas on your
benthic structures map with a pen and explain why you chose the areas you did.
What to turn in

1. Answers to the questions above.

2. Layouts showing fine-scale BPI, broad-scale BPI and benthic zones.
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Spatial and 3D Analysts
Introduction

Spatial Analyst is the tool ArcGIS uses to conduct analyses with raster data. 3D Analyst
and ArcScene allow users to display and work with three-dimensional data. Although
they are not truly 3D, in that no three-dimensional calculations, such as volume, can be
done on data, they are important tools for displaying data.

Objectives--By the end of this lesson, you should be
able to: Note: A Buffer Analysis

e Create a new shapefile. defines an area around a

feature of interest, in this
* Add data to a shapefile. ) . case, coral. In this case, the
* Convert a bathymetry grid to a 3D display.

: - buffered area around the
* Complete viewshed and hillshade analyses coral can help identify an

* Select features with the attribute table area that would provide
* Buffer a shapefile. protection for coral and reef
* Define: Viewshed and hillshade fish.

1. Add the FBNMS bathy grid to the project.
2. Make sure the Spatial Analyst and the 3D Analyst Extensions are turned on.
a. Go to Tools=> Extensions.
b. Check the boxes next to Spatial Analyst and 3D Analyst.
c. To add the Spatial Analyst toolbar, go to View > Toolbar->Spatial Analyst.
d. Add the 3D Analyst Toolbar in the same manner.

1. Create a slope grid like you

did in the previous lesson. Note: Make sure you are saving where you
2. Right click on the new grid intend! Check the folder in the top of the Save

and choose make As dialog box. When naming raster files, the

permanent. Important: name can only be 13 characters long and it is

Save your grid in the same never a good idea to have spaces in a filename.

folder that contains the

bathymetry grid.

Hillshade: Hillshade analysis is a way to see where light would fall on a landscape. The
resulting grid will appear as a grayscale (black & white) image. Hillshade often shows
the landscape quite dramatically. Compare the hillshade grid to the original bathymetry
grid.

1. On the Spatial Analyst Toolbar, go to Spatial Analysis=> Surface Analysis—>
Hillshade. This will bring up the Hillshade dialog box (Figure 20).
2. Make sure the bathymetry grid is showing in the Input Surface field.
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3. For now, leave Azimuth and Altitude. v —E
. surface: tualm_nas v >
4. Change the Output Cell Size to 1 and choose a rm' i dgl]s L
filename the same way you did above for :
slope. Click OKk. [A_'m = |
Model shadows
5. Compare the Hillshade grid to the slope grid i A :
you made earlier. sl . -
Output raster: <Temporary> =3
a. What type of slope values appear in the ok ]| _ Corcsl |
areas that appear the steepest in the Figure 20—The Hillshade
hillshade grld? Dialog Box.

b. Try experimenting with several different
Azimuth and Altitude values to see what

Azimuth is the direction from

happens when they are changed. What which the light is coming.
azimuth value makes the grid look inverted North is 0° and, moving in a
(i.e. ridges look like valleys)? clockwise direction, the degrees

increase. The most commonly
6. When you have a hillshade that you like, click used azimuth for mapping is
on the title of the bathymetry grid and drag it 315, which would be northwest.

above the hillshade grid.
Altitude is the angle of the light

source (sun) above the horizon.
Forty-five degrees is the most
commonly used altitude.

7. Add the Effects toolbar in the same way you
added the Spatial Analyst toolbar.

8. In the Layer box on the Effects toolbar, make sure the bathymetry grid is showing.

Click on the Transparency Elbutton. This will bring up a slider bar: Set the
transparency to something around 50%. The greater the percentage, the more
transparent the layer.

9. Create a layout showing your hillshade with bathymetry over it. Remember to include
a title, your name, a north arrow, a scale bar, and the date.

Creating and Editing a Theme
We need to create a new point shapefile.
1. Open ArcCatalog.

2. Go to File>New=> Shapefile. In the Create New Shapefile dialog box, change the
name of the file to something meaningful. Make sure that Feature Type is Point and
click Ok.

3. Go back to ArcMap and add the shapefile you just created to your project. Make sure
the Editor toolbar is visible. If not, add it.
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On the Editor Toolbar, go to Editor->Start Editing.

Click on the Digitize Tool? ™ |. On the map, add points to the shapefile by clicking
on the map. A colored point will appear. Add five or six points.

6. Save your edits by going to Editor->Save Edits.

7. Stop editing by going to Editor - Stop Editing

8. You will use this shapefile later in the lab. Save your project and exit ArcMap.
3D Analyst

1. Open ArcScene. Add the bathymetry layer the same way you would add a layer in

4.

ArcMap. Make sure 3D Analyst is turned on (see the instructions on page 1 for how
to do this.

Layer Properties

In the 3D Analyst toolbar (if the toolbar is not o] Soace| Evot| i ol B Highs | o
showing, add it the same way you added the Heign
spatial analyst toolbar earlier), choose Convert--  oacomrt ke emesion o e tensie e
>Raster to TIN. The input file should be the
bathymetry ﬁle' Choose a ﬁlename for the ()lltlj)llt ( IZ:\Am moahProjectsyB enthicH abitat\D atahIMS_gridshrastting
file and make sure it is being saved in the correct e Feshon..|

location. Click Ok. Be patient, this will take a Loy feataes e 2 vlics e ther fo g
while. Z Uit Conversion

’VApply conversion factor to place heights in same units as scene; I-

&+ Obtain helyhts for layer fom suface:

When the TIN appears, right-click on the P
bathymetry file and go to Properties. Click on the L“

Base Heights tab. Click the Obtain heights for
layer from surface option (Figure 21). Choose the

TIN file you just created from the pulldown menu. . — :
Click OK. Figure 21—Choose “obtain heights

from surface.”

Turn off the TIN layer. The bathymetry later should now be 3D.

Viewshed Analysis

A viewshed analysis shows you what can be seen from a point on a raster file. This

analysis is commonly used to determine what can
be seen from a given point in an area. Note: You may have to rotate the

1.

image using B mae it appear
Go to 3D Analyst->Surface correctly. ArcScene does not

Viewshed dialog box.




For Input Surface choose the bathymetry grid.

Change the Output Cell Size to 1.

ac oe

the name must be 13 characters or less.
e. Click Ok.

The viewshed file will appear in the layer list. It
will be composed of two colors, one for visible
areas and one for areas that would not be visible
from the observer points. In other words, if you
were diving at one of the points, the visible areas
are the areas you could see from that point.

a. What types of applications can you see for a
viewshed analysis, either land or sea-based?

b. What industries use viewshed analysis? You
may have to search the internet to find this
out. Be sure to say where you got your
information.

Add the hillshade file you created earlier in this
lab. Make sure the viewshed file is first in the
layer list and the hillshade file is second in the
layer list.

Turn off all other layers.

For Observer Points choose the point shapefile you created on page 3.

Layer Properties

General' SDurce' EHtant' Display' Symbology  Base Heights |H
i~ Height

1 Use a constant value or expression to set heights for layer.
In

* Dhtain heights for layer from surface:

IZ:\AmS amoaiProjects\B enthicH abitat\D atab WS _gridshrast

Fiaster Resolution... |

10 Layer features have 2 values, Use them for heights,

Z Unit Conversion

’VApply cohversion factor to place heights in same units as scene:

Offget
’indd an offset uszing a constant or expression;
o

I

Figure 22—An offset is needed to
make the layers display correctly.

Set the Base Heights for the viewshed to the TIN you created as described above.
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Choose a filename. Since the output viewshed file will be a raster file, remember,

Set the Base Heights for the hillshade in the same manner. Before you click Ok, set

an offset for the Hillshade of —10 in the Offset box of the Base Heights tab (Figure

22). Click OKk.

Set the transparency of the viewshed file to somewhere around 50%. You may need

to rotate the display to get it to display correctly.

Do a screenshot of your viewshed file on top of the hillshade. To do this, press the
Print Screen (PrtScrn) button on the keyboard. Open Microsoft Word with a new
document. Either do a Ctrl-->V or go to Edit-->Paste and your image will appear.

Save your project.

MPA Designation
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Designating Marine Protected Areas (MPAs) can be difficult. It is important that the
place chosen to be an MPA protect as many species as possible, often in the smallest
possible area. Not only must you determine where the best location is for an MPA, you
have to work with the people who would be affected by a marine reserve to make sure
they, at the very least, do not oppose the MPA. There are two kinds of MPAs in
American Samoa: no-take MPAs and MPAs where limited fishing is still allowed. The
only no-take MPA in American Samoa is Rose Atoll National Wildlife Sanctuary.

. . 1il
1. How many federal MPAs are in American Layet Eroparties

Samoa? General | Source | Selection | Display Symbology | Fiekds | Defin
Draw categories using unique valud
2. What types of ﬁshing are allowed in Fagatele e ?;:?AF:‘_"MOD -
Bay National Marine Sanctuary and National Unique vakes,
Park of American Samoa | Sbal [ Ve L
((Jo  <alothervaes e
(http://www.fbnms.nos.noaa.gov/ and Muliple Atibutes | Heading> o
. | o 10%<50% 107
http://www.nps.gov/npsa/home.htm/)? 4 Aaoad Agg
E o  Aggeg Patch Reef Agd
3. Add ftua_bathy and B b i
. . |
Fagaitua_groundtruth, to your project. Eb oy ™
Make sure they are all visible. | o UnoPmesn  Un
AddAIValues | Add Vakues
a. Zoom to Fagaitua Bay (see map at left). R
b. Go to Properties and click on the [
Symbology tab. Change how the layer is Figure 23—Classify the points
displayed by clicking on Categories and based on unique values.

then Unique Values (Figure 23).

i. In the Value Field pulldown menu, choose AREA_ 1 _MOD.
ii. Click the Add All Values button. Ifthe color scheme is something you
like, click Ok. Otherwise, choose a different color scheme and click ok.

c. Use the Identify tool and click on several points.

4. Open the Attribute Table for Fagaitua_groundtruth. Right-click on the name of
the file and choose Open Attribute Table.

a. Click on the Options—> Select By Attribute (Figure 24). This will bring
up the Select By Attributes Window (Figure 25).
b. Under Fields, double-click on “AREA_1_MOD”
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Select by Attributes @
ARSSIFLESHY MA COLON HAR UNCO Enter a WHERE clause to select records in the table window.

0 Colon. Pavement Method : |Cveale anew selection L}
0 Colon. Pavement Fields: Unique Values
0 Colon. Pavement -~ e
0 Reef Rubble "UNCONSOLID"

"SEAGRASS" _I _I And
0 "FLESHY_MAC"
0 Reef Rubble "COLON__HAR"
0 Reef R:bble TONCOL_HAR' x

"ENCRUST_CO* t
0 “OTHER" ‘J—[ —-—J et | e
0 Agareg. Coral %2’}‘5 w 3 Is GoTo:
0 10%-<50% < > Get Unique Values
0 SELECT * FROM tut_ptsfinal_ftuaclip WHERE:
0 Colon. Pavement
0 Agareg. Coral
0 Colon. Pavement
0 Colon. Pavement
0
0
0
2 | | Hep | Load. | |

b | Records (0 outof 144 Selected)  (C Opiions +|) Close

N N el
Figure 24—The attribute table.
The options button allows you to
select records

Figure 25—The Select by Attributes
window

Click the = button

Click the Get Unique Values button.

Under Unique Values, double-click on ‘Aggreg. Coral’
In the Select From...box, it should look like this:
"AREA 1 MOD" ="'Aggreg. Coral'

Click Apply.

Close the Select By Attributes window.

Look at the Attribute Table.

Look at the map, the points that are highlighted are those that you selected
in the attribute table.

k. Go to Options=>Clear Selection.

o Ao

L

5. Now you will find out where most of the coral in Fagaitua Bay is located. To do
that, you will have to select points based on more than one Unique Value using
the OR connector.

a.
b.
C.

Follow steps 5 a-f above.

Click the OR button.

Repeat step 6a, but this time, instead of choosing ‘Aggreg. Coral’ for the
Unique Value, choose ‘Colon. Pavement’.

Click the OR button.

Repeat steps 6¢ and 6d for the following Unique Values: Indivd. Patch Reef,
Aggreg. Patch Reef, Colon. Pavement, and Scat. Coral/Rock.

Click Apply.

Close the Select by Attributes window.



Export Data e 2ix

h. Inthe Attribute Table, some records will
be highlighted. If you just want to see

Export: [Selecled features 3

' Use the same Coordinate System as this layer's source data.

the selected records, click the Selected L

buttOH. If y0u Wal’lt tO S€cC all Of the Output shapefile or feature class:

records again’ Click the All button. 12\AmSamoa\on;ecis\Bemhchabltak\Dala\ModuIes_lesl\Expml_ E”'J
i. On the map, all of the selected points Gt |

will be highlighted Figure 26—Exporting points as a

. . hapefile.
j.  Make a layout showing the selected few shapettie

points.

6. Now we are going to buffer around the coral points to determine the best place for
an imaginary marine protected area.

a. Right-click on the fiua_ptsfinal in the layer list. Choose Data—>Export Data.
Make sure Selected Features is showing in the Export pull-down menu. In the
Output box, name your file ftua_coral (Figure 26).

b. Turn off the Fagaitua_groundtruth layer.

c. Go to Tools=>Buffer
Wizard.

How do you want to create buffers?

d. Choose The Features of a I
Layer and make sure

" Based on a distance from an attibute

ftua_coral is showing in the |
pull-down menu. Click Next. 2ol
e. Change the Buffer Units to
Meters. ~ Bulfer distance
f.  We want to create a 100 e —
meter buffer around the coral,
so type 100 in the box after .
At a Specified Distance Figure 27—Buffer Wizard.
(Figure 27). Click Next.
g. Make sure that Yes is checked under Dissolve Barriers. Click Finish.

|
=
T

< Back Next > Cancel

7. Now you need to decide where to designate an MPA.
a. Some things to keep in mind:
i. An MPA should be efficient: It should protect as much as possible while
placing restrictions on as little area as possible.
ii. Many MPAs prohibit all fishing and collection, while others allow some
types of fishing and collection.
iii. You will have to get people affected by the MPA rules to agree to them.
iv. An MPA that only protects shallow areas may not protect fish that spend
part of their time in deep water.
b. Make a layout showing the buffered areas and draw where you will create an
MPA. Keep in mind this is an imaginary MPA, but you will have to come up
with a strategy to sell it to people who fish there.
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8. Questions:

a.
b.
C.

How many points are classified as Aggregate Coral?
How many total points have coral (step 6)?
What areas of the bay have the densest clustering of coral?

9. Write a brief proposal (3-5 pages) with maps about your MPA. You will need to
include maps of where the coral is located, where you propose to locate an MPA
and what villages are affected (you may want to use tut_villages). Be sure to
answer the following questions in the proposal:

a.

List four species of reef fish people eat in American Samoa. If you know the
English name, find out the Samoan name. If you know the Samoan name, find
out the English name. Use the National Park of American Samoa Fish
Inventory for help with names (http://www.nps.gov/npsa/NPSAfish/).

What kinds of fish might be protected by protecting coral? Use the Natural
History Guide to American Samoa (http://www.nps.gov/npsa/book/index.htm)

for more information. Be sure to cite your sources.

Why did you choose to protect the area you did?
Who would be affected by prohibiting all fishing in Fagaitua Bay?

Which villages would you have to work with to create an MPA in Fagaitua
Bay?

How would you convince these villages to agree to a fishing ban? Outline a
strategy for talking to villages, including who you would ask for help.

What kinds of maps and information would you use to convince village leaders
that an MPA is necessary in their area? Be sure to include these in the
proposal.

If you were going to allow some kinds of fishing, what kinds would you allow?
What regulations will your MPA have?

How will you enforce the regulations?

If it was impossible to establish an MPA in Fagaitua Bay, where would be a
good alternative?
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What to Turn In
1. Answers to questions.

2. A layout showing the hillshade overlain by bathymetry.

3. An image showing the viewshed file on top of the
hillshade from ArcScene. Figure 28—A giant clam

(faisua) from National Park
. . . of American Samoa. (Photo
5. A layout showing the points with coral. by E. Larkin). (

6. Your MPA proposal.





